Make sure you check for updates to this manual at the Oracle Technology Network (OTN) Web site
Copyrights and Trademarks

Copyright © 1995, 2007, Oracle. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee’s responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

Oracle and Agile are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.

September 12, 2007
## Revisions

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Pages Affected</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>05/05/06</td>
<td>All</td>
<td>Initial release of manual.</td>
</tr>
<tr>
<td>B</td>
<td>05/23/06</td>
<td>3-5, 4-3, 4-4</td>
<td>Made corrections to Solaris and Linux steps.</td>
</tr>
<tr>
<td>C</td>
<td>06/05/06</td>
<td>Chapters 5-7</td>
<td>Removed upgrade instructions from Chapter 5 to create a new chapter (Chapter 7), added new chapter on installing PI on Solaris (Chapter 6).</td>
</tr>
<tr>
<td>D</td>
<td>06/08/06</td>
<td>3-7, 4-6</td>
<td>Updated the Oracle Net Manager steps.</td>
</tr>
<tr>
<td>E</td>
<td>07/19/06</td>
<td>1-2</td>
<td>Corrected Windows 2003 version.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A-2, B-2</td>
<td>Added note regarding computer name and DNS hostname.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3-5, 6-5</td>
<td>Added section on vxfs file system support.</td>
</tr>
<tr>
<td>F</td>
<td>09/21/06</td>
<td>2-4, 3-8</td>
<td>Added sentence on configuring the listener if upgrading.</td>
</tr>
</tbody>
</table>
# CONTENTS

## Preface
- Agile PLM Documentation ............................................................. ix
- Readme ................................................................. ix
- Agile Training Aids ............................................................. ix
- Developer Documentation and Samples ........................................... ix

## Chapter 1  Overview of Agile Database Installation
- Agile System Requirements ........................................................ 1-1
- Operating System Requirements .................................................. 1-2
- Hardware Requirements .............................................................. 1-2
- Database Hardware Configuration ................................................ 1-3
- RAID Configuration ................................................................. 1-5
- Disk I/O Configurations .............................................................. 1-5
- One-Disk ................................................................. 1-6
- Four-Disk Configuration ............................................................. 1-6
- Nine-Disk Configuration ............................................................. 1-6
- Twelve-Disk Configuration ......................................................... 1-7

## Chapter 2  Installing the Agile Database on Windows
- Installation Notes ................................................................. 2-2
- Copying the Agile CDs ............................................................. 2-2
- Installing the Oracle Database ................................................... 2-2
- Starting the Installer ............................................................... 2-2
  - Installer Buttons ............................................................... 2-2
  - Installer Online Help .......................................................... 2-3
- Using the Agile Database Configuration Utility .............................. 2-3
- Adding and Configuring the Listener ........................................... 2-4
- Configuring Oracle Database Control (Optional) .......................... 2-5

## Chapter 3  Installing the Agile Database on Solaris
- Overview ................................................................. 3-2
  - Oracle Source Documentation ................................................ 3-2
  - System Requirements .......................................................... 3-2
- Preparing the Host Computer .................................................... 3-2
  - Making the Oracle Installer Available ...................................... 3-5
  - Installing the Oracle Database ................................................ 3-5
  - vxfs File System Support ..................................................... 3-5
- Creating the Agile Database ...................................................... 3-5
- Post-Installation Tasks ............................................................ 3-5
  - Setting Up Oracle Net Manager .............................................. 3-7
  - Setting Up Automatic Shutdown and Startup for the Database ........ 3-8
  - Configuring the listener.ora File ........................................... 3-8
  - Configuring the tnsnames.ora File (Optional) ............................ 3-8
Chapter 4  Installing the Agile Database on Linux
Overview ................................................................. 4-2
Oracle Source Documentation ........................................ 4-2
System Requirements .................................................. 4-2
Preparing the Host Computer ........................................ 4-2
  Making the Oracle Installer Available ............................ 4-4
  Installing the Oracle Database ................................... 4-4
Creating the Agile Database ........................................... 4-4
Post-Installation Tasks ................................................ 4-6
  Setting Up Oracle Net Manager ................................ 4-6
  Setting Up Automatic Shutdown and Startup for the Database 4-7
  Configuring the listener.ora File .................................. 4-7
  Configuring the tnsnames.ora File (Optional) .................. 4-8

Chapter 5  Installing the Product Interchange Database on Windows
Installation Notes ...................................................... 5-2
Copying the Agile CDs ................................................ 5-2
Installing the Oracle Database ....................................... 5-2
Starting the Installer ................................................... 5-2
  Installer Buttons .................................................... 5-2
  Installer Online Help .............................................. 5-3
Agile PLM Components .............................................. 5-3
Using the Product Interchange Database Customization Utility 5-3
Adding and Configuring the Listener ............................... 5-4
Configuring Oracle Database Control (Optional) ................. 5-5

Chapter 6  Installing the Product Interchange Database on Solaris
Overview ................................................................. 6-2
Oracle Source Documentation ........................................ 6-2
System Requirements .................................................. 6-2
Preparing the Host Computer ........................................ 6-2
  Making the Oracle Installer Available ............................ 6-5
  Installing the Oracle Database ................................... 6-5
  vxfs File System Support ......................................... 6-5
Creating the Product Interchange Database ......................... 6-5
Post-Installation Tasks ................................................ 6-7
  Setting Up Oracle Net Manager ................................ 6-7
  Setting Up Automatic Shutdown and Startup for the Database 6-8
  Configuring the listener.ora File .................................. 6-9
  Configuring the tnsnames.ora File (Optional) .................. 6-10

Chapter 7  Upgrading the Product Interchange Database
Upgrading the Product Interchange Database ..................... 7-1

Appendix A  Installing Oracle 9i
Before Installing Oracle 9i on Windows ................................ A-1
Network Check .......................................................... A-1
  Confirming Computer Name and Hostname Identities .......... A-1
  Confirming the Server Date ....................................... A-2
  Checking the Windows File System .............................. A-2
Installing Oracle 9i Release 2 on Windows ....................................................... A-2
   Editing the sqlnet.ora File ................................................................. A-3
Making the Oracle Installer Available on Solaris. ........................................ A-4
Installing Oracle 9i Release 2 on Solaris ..................................................... A-4

Appendix B    Installing Oracle 10g
Before Installing Oracle 10g on Windows .................................................. B-1
   Network Check .................................................................................... B-1
      Confirming Computer Name and Hostname Identities ........................ B-1
      Confirming the Server Date ............................................................ B-2
   Checking the Windows File System .................................................... B-2
      For Servers Configured with DHCP ................................................ B-2
Installing Oracle 10g Release 2 on Windows .............................................. B-3
Making the Oracle Installer Available on Solaris. ......................................... B-5
Making the Oracle Installer Available on Linux ........................................... B-5
Installing Oracle 10g Release 2 on Solaris and Linux .................................. B-6

Appendix C    Database Management
Database Maintenance ................................................................. C-1
   Fine-Tuning Index Settings ............................................................. C-1
   Monthly Maintenance ................................................................. C-1
   Checking Database Space Allocation .............................................. C-2
   Dynamic Versus Static IP Addresses .............................................. C-2
Backing Up the Database ........................................................................ C-2
   Backup and Recovery Strategy ......................................................... C-3
   Implementing Backup Procedures ................................................... C-4
   Useful Information for Backup and Maintenance Tools ..................... C-5
   Types of Backups ............................................................................... C-5
      Performing System Backups .......................................................... C-5
      Using Standby Databases ............................................................. C-6
      Performing Database Backups ...................................................... C-6
      Performing Cold Backups ............................................................ C-6
      Performing Hot Backups ............................................................. C-7
Importing the Database .......................................................................... C-7
Exporting the Database ........................................................................ C-9
   Exporting the Full Oracle Database ................................................ C-9
   Exporting the Agile Schema from Oracle ........................................ C-9
Creating a Schema in Oracle .................................................................... C-10
Deleting an Instance and the Database Files ........................................... C-11
Database Recovery ............................................................................. C-12
   Using Oracle Recovery Manager ..................................................... C-12
Running Scripts ................................................................................... C-12

Index
PREFACE

The Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology Network (OTN) Web site contains the latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation folder available on your network from which you can access the Oracle|Agile documentation (PDF) files.

To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. This program can be downloaded from the www.adobe.com.

The Oracle Technology Network (OTN) Web site can be accessed through Help > Manuals in both the Agile Web Client and the Agile Java Client. If applicable, earlier versions of Oracle|Agile PLM documentation can be found on the www.agile.com/support.

If you need additional assistance or information, please contact support@agile.com or phone (408) 284-3900 for assistance.

Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please have ready the full part number, which is located on the title page.

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle Technology Network (OTN) Web site.

Agile Training Aids

Go to the Agile Training Web page for more information on Agile Training offerings.
This chapter describes the Agile components you need to install, possible deployment choices, and system requirements or recommendations. It includes these topics:

- Agile System Requirements
- Database Hardware Configuration
- RAID Configuration
- Disk I/O Configurations

**Agile System Requirements**

Depending on the size and type of network system in each site, Agile PLM 9.2.1 may be deployed in different configurations. The amount of time required to complete an installation depends on the complexity of your Agile PLM implementation.

*Note* For installations using a certified localized language, all server components must be installed on computers running the same localized OS. Clients can be running on the same localized OS or English OS. For detailed information about using Agile with international operating systems, contact the Agile support Web site.

Agile can be distributed over a wide-area network with multiple servers or can be limited to one or two server computers with several client computers. In the latter case, Agile can usually be installed within a half day. However, network-based systems are inherently complex, and some installations require additional time.

Agile recommends installing the Oracle database on a separate computer than the other Agile components.

It is acceptable to install multiple server components on the same computer if the additional resources are not available. However, the minimum hardware requirements must be increased based on the number of server components installed on a single computer.
Operating System Requirements

You should install only supported versions of Agile components that are within the same release. You should not attempt to install Agile components on unspecified operating systems. Contact your Agile Solutions Consultant or Agile Technical Support for special requirements.

Table 1-1: Operating System requirements

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows</td>
<td>2003</td>
</tr>
<tr>
<td>Solaris</td>
<td>Release 9 and 10</td>
</tr>
<tr>
<td>Linux</td>
<td>RedHat Linux 4.0</td>
</tr>
</tbody>
</table>

Hardware Requirements

Before you can install Agile server components, you must have at least 1 GB of available disk space available where the OS is installed, in addition to the minimum disk space requirements specified in the Capacity Planning and Deployment Guide.

Important Agile computers and databases should be dedicated to Agile and should not have other software installed, unless otherwise specified. Do not attempt to include other database schemas or use the Agile host server as the primary domain controller (PDC) or dynamic host configuration protocol (DHCP) server.

Disk compression must be disabled on Agile computers.

When choosing a hardware configuration, consider the number of total users, the number of concurrent users, the size of your database, the number of ECOs processed per day, and overall activity level. If you have questions about your system, Agile Technical Support or your Agile Solutions Consultant can give guidance on whether you have small, medium, or large system requirements.

It is required that the computer on which you are installing Agile components and the Oracle database have at least two physical drives or two partitions. This allows you to place the operating system on the C drive and use the D drive for Agile or Oracle components.

Note If you have only one drive or one partition, you will not be able to use the Agile Database Configuration utility.

Tables 1-2 through 1-5 provide summary information for minimum hardware requirements based on database size.

Table 1-2: Minimum hardware requirements—small database system (100 MB to 1 GB)

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Windows and Linux</th>
<th>Solaris</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Dual, 1.8 GHz Intel Xeon</td>
<td>Dual 900MHz Ultra Sparc III</td>
</tr>
<tr>
<td>RAM (GB)</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Number and size of disks (partitions)</td>
<td>Four 18 GB</td>
<td>Four 18 GB</td>
</tr>
</tbody>
</table>

Table 1-3: Minimum hardware requirements—medium database system (1 GB to 5 GB)

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Windows and Linux</th>
<th>Solaris</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Dual, 1.8 GHz Intel Xeon</td>
<td>Dual 900 MHz Ultra Sparc</td>
</tr>
<tr>
<td>RAM (GB)</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Number and size of disks (partitions)</td>
<td>Four 18 GB</td>
<td>Four 18 GB</td>
</tr>
</tbody>
</table>

Table 1-4: Minimum hardware requirements—large database system (2 GB to 16 GB)

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Windows and Linux</th>
<th>Solaris</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Four, 1.8 GHz Intel Xeon</td>
<td>Four 900 MHz Ultra Sparc III</td>
</tr>
</tbody>
</table>

Table 1-5: Minimum hardware requirements—extra large database system (16 GB to 64 GB)

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Windows and Linux</th>
<th>Solaris</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Four, 1.8 GHz Intel Xeon</td>
<td>Four 900 MHz Ultra Sparc III</td>
</tr>
</tbody>
</table>
The Agile database uses Oracle 9.2.0.1.0 or 10.2.0.1. An email system based on SMTP or SMTP gateway is also required. Recommended database hardware depends on your Agile system configuration.

If you have only single processor computers and anticipate high network traffic, then the database and Agile Application Server should be installed on two different computers to avoid competition for resources on a single computer, which would outweigh any advantage gained from reduced network traffic.

Oracle recommends separate disks for the operating system and database.

### Database Hardware Configuration

Agile uses four database configurations (A through D), as shown in Table 1-6. In addition, Tables 1-2 through 1-5 provide the minimum hardware configuration based on the database sizing model. Each database configuration provides necessary hardware resources to support the Agile database sizing model.

Taking into account the hardware requirements specified in Table 1-6, each configuration is intended for a specific database sizing model. The minimum hardware requirements should be followed to satisfy the Agile database installation. To increase the scalability and concurrency for any configuration, provide additional CPUs, RAM, and disk space.

- Configuration A provides the initial hardware resources for implementing the small database sizing model.
- Configuration B provides the minimum hardware resources for implementing the medium (regular) database sizing model.
- Configuration C provides the minimum hardware resources for implementing the large database sizing model.
- Configuration D provides the minimum hardware resources for implementing the extra-large database sizing model.

### Table 1-4: Minimum hardware requirements—large database system (2 GB to 16 GB) (continued)

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Windows and Linux</th>
<th>Solaris</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM (GB)</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Number and size of disks (partitions)</td>
<td>Nine 18 GB</td>
<td>Nine 18 GB</td>
</tr>
</tbody>
</table>

### Table 1-5: Minimum hardware requirements—extra-large database system (5 GB to 38 GB)

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Windows and Linux</th>
<th>Solaris</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Eight, 1.8 GHz Intel Xeon</td>
<td>Eight 900 MHz Ultra Sparc III</td>
</tr>
<tr>
<td>RAM (GB)</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>Number and size of disks (partitions)</td>
<td>Twelve 18 GB</td>
<td>Twelve 18 GB</td>
</tr>
</tbody>
</table>
You should take the platform into consideration when you select the Agile database configuration. When you choose the Windows platform for database deployment, you should consider the potential that additional resources will be required for scaling the application within one or two years. Agile recommends using the Windows platform for a database with relatively moderate growth. For enterprise-level usage with a high-growth potential, it may be beneficial to adopt the Solaris platform, which is easily expanded in CPUs and RAM.

Depending on the database sizing and configuration model you follow, the database could potentially support the following:

- **Small database model**
  - Configuration A supports up to 100 concurrent users
  - Configuration B supports up to 250 concurrent users
  - Configuration C supports up to 500 concurrent users
  - Configuration D supports up to 1,000 concurrent users

- **Medium (regular) database model**
  - Configuration A supports up to 100 concurrent users
  - Configuration B supports up to 250 concurrent users
  - Configuration C supports up to 500 concurrent users
  - Configuration D supports up to 1,000 concurrent users

- **Large database model**
  - Configuration B supports up to 250 concurrent users

---

<table>
<thead>
<tr>
<th>Agile DB Configuration</th>
<th>Operational System Platform</th>
<th>Logged In Peaktimes Active users</th>
<th>Database Server Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>CPU</td>
<td>RAM</td>
</tr>
<tr>
<td>D</td>
<td>Solaris/Windows/Linux</td>
<td>1000</td>
<td>8GB</td>
</tr>
<tr>
<td>C</td>
<td>Solaris/Windows/Linux</td>
<td>500</td>
<td>4GB</td>
</tr>
<tr>
<td>B</td>
<td>Windows/Solaris/Linux</td>
<td>250</td>
<td>2GB</td>
</tr>
<tr>
<td>A</td>
<td>Windows/Solaris/Linux</td>
<td>100</td>
<td>2GB</td>
</tr>
<tr>
<td>DEMO</td>
<td>Windows/Linux</td>
<td>1</td>
<td>.5GB</td>
</tr>
</tbody>
</table>

**Table 1-6: Agile PLM 9.2.1 Database Sizing Matrix**

- **Database Sizing Model**
  - Small
  - Medium
  - Large
• Configuration C supports up to 500 concurrent users
• Configuration D supports up to 1,000 concurrent users

- Extra-large database model
  • Configuration C supports up to 500 concurrent users
  • Configuration D supports up to 1,000 concurrent users

**RAID Configuration**

RAID 1 mirroring is highly recommended because of its high tolerance for hardware fault. Although the following section refers to one-disk, four-disk, nine-disk, and twelve-disk configurations, the RAID 1 configuration doubles the number of disks installed. It should also be noted that RAID 0+1 is the best configuration in a nine-disk or twelve-disk configuration. In fact, such a hardware configuration normally requires an external disk storage enclosure.

RAID 5 is highly discouraged for Agile PLM database deployment. At a minimum, redo logs should not be stored in disks configured with RAID 5.

**Disk I/O Configurations**

While the proper sizing of extents minimizes dynamic extensions in the same segments, disk I/O contention within the same logical tablespace or physical data file can also be harmful.

You can improve disk I/O performance for multiple disk configurations by spreading the I/O burden across multiple disk devices. The following sections describe the use of multiple disks for the Oracle database server. It is always advisable to use more disks.

There are eight tablespaces in the Agile PLM 9.2.1 database configuration: AGILE_DATA1, AGILE_DATA2, AGILE_DATA3, and AGILE_DATA4 for Agile table segments, and AGILE_INDX1, AGILE_INDX2, AGILE_INDX3, and AGILE_INDX4 for Agile index segments.

- **Note**: There is an additional tablespace, SYSAUX, available with Oracle 10g. If you are using an Oracle 10g database, add the SYSAUX tablespace to the same drive as the SYSTEM tablespace.

Table 1-7: One-disk configuration

<table>
<thead>
<tr>
<th>Disks (no RAID)</th>
<th>Disks (RAID 1)</th>
<th>Drive/ Mount Point</th>
<th>Oracle_Home</th>
<th>Tablespaces</th>
<th>Redo Logfiles</th>
<th>Control files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk 0</td>
<td>Disk 0/1</td>
<td>D or /u01</td>
<td>Oracle_Home</td>
<td>SYSTEM</td>
<td>LOG1, LOG2, LOG3, LOG4</td>
<td>Control file01, Control file02, Control file03</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TOOLS, UNDO, TEMP, USERS, INDX, AGILE_DATA1, AGILE_DATA2, AGILE_DATA3, AGILE_DATA4, AGILE_INDX1, AGILE_INDX2, AGILE_INDX3, AGILE_INDX4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
One-Disk

A one-disk configuration is best for a demonstration, preproduction, and testing environment. This configuration results in disk I/O contention. In addition, as both usage and database size increase, performance significantly declines. The one-disk configuration is intended for demo database applications only, and the configuration can be implemented as shown in Table 1-7.

There is no beneficial gain from OFA for the one-disk configuration from the perspective of disk I/O contention. There should be no significant impact on a current production database if you implement the default Oracle settings with a one-disk configuration.

Four-Disk Configuration

A four-disk configuration is best for an enterprise-level implementation of Agile. A four-disk configuration spreads the various data files, control files, and redo log files across multiple disk devices.

First of all, the three control files can be mirrored onto three different disks for best recovery protection.

Second, all potential I/O demand-intensive data files can be distributed onto their own separate disk. Redo log files are partially isolated from the rest of the data files, as the log files can cause significant I/O contention during transactions if they are sharing disks with other data files. The UNDO data file is separated from the schema data files and log files as well, so I/O contention during import and upgrade can be minimized.

Third, the Agile schema tablespaces can be isolated from the rest of the SYSTEM, TEMP, TOOLS, and UNDO data files.

### Table 1-8: Four-disk configuration for OFA implementation

<table>
<thead>
<tr>
<th>Disks (no RAID)</th>
<th>Disks (RAID 1)</th>
<th>Drive/ Mount Point</th>
<th>Oracle_Home</th>
<th>Tablespaces</th>
<th>Redo Logfiles</th>
<th>Control files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk 0</td>
<td>Disk 0/1</td>
<td>D or /u01</td>
<td>Oracle_Home</td>
<td>SYSTEM/TOOL/UNDO</td>
<td></td>
<td>Control file01</td>
</tr>
<tr>
<td>Disk 1</td>
<td>Disk 2/3</td>
<td>E or /u02</td>
<td></td>
<td>TEMP/USERS/INDX</td>
<td>Archive log file</td>
<td>Control file02</td>
</tr>
<tr>
<td>Disk 2</td>
<td>Disk 4/5</td>
<td>F or /u03</td>
<td>AGILE_INDX1</td>
<td>AGILE_INDX2</td>
<td>AGILE_INDX3</td>
<td>LOG1/2/3/4</td>
</tr>
<tr>
<td>Disk 3</td>
<td>Disk 6/7</td>
<td>G or /u04</td>
<td>AGILE_DATA1</td>
<td>AGILE_DATA2</td>
<td>AGILE_DATA3</td>
<td>AGILE_DATA4</td>
</tr>
</tbody>
</table>

The four-disk configuration shown in Table 1-8 is recommended. For production database sites, the four-disk configuration represents the minimum requirements for an OFA implementation and provides the minimum hardware configuration for performance tuning.

Nine-Disk Configuration

In addition to the advantages associated with a four-disk configuration, a nine-disk configuration supports an enterprise-level implementation of Agile by further spreading various data files and redo log files across multiple disk devices.
Chapter 1

Overview of Agile Database Installation

Application schema can obtain additional performance gains in terms of I/O load spread by further separating the AGILE_DATA1, AGILE_DATA2, AGILE_DATA3 and AGILE_INDX1, AGILE_INDX2, AGILE_INDX3 data files because of potential I/O contention between the AGILE_DATA data files and AGILE_INDX data files. For supporting a full text search content index, a complete separation of potential large datafiles in its own disk spindle should help I/O contention as physical disk I/O is inevitable, due to the share size of data, as shown in Table 1-9.

Table 1-9: Nine-disk configuration for OFA implementation with mirroring

<table>
<thead>
<tr>
<th>Disks (no RAID)</th>
<th>Disks (RAID 1)</th>
<th>Drive/ Mount Point</th>
<th>Oracle_Home</th>
<th>Tablespaces</th>
<th>Redo Logfiles</th>
<th>Control files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk 0</td>
<td>Disk 0/1</td>
<td>C or /u01</td>
<td>Oracle_Home</td>
<td>SYSTEM/TOOL/UNDO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 1</td>
<td>Disk 2/3</td>
<td>D or /u02</td>
<td>TEMP/USERS/INDX</td>
<td></td>
<td>Control file01</td>
<td></td>
</tr>
<tr>
<td>Disk 2</td>
<td>Disk 4/5</td>
<td>E or /u03</td>
<td>LOG 1/2/3/4</td>
<td>Control file02</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 3</td>
<td>Disk 6/7</td>
<td>F or /u04</td>
<td>Archive log file</td>
<td></td>
<td>Control file03</td>
<td></td>
</tr>
<tr>
<td>Disk 4</td>
<td>Disk 8/9</td>
<td>G or /u05</td>
<td>AGILE_DATA1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 5</td>
<td>Disk 10/11</td>
<td>H or /u06</td>
<td>AGILE_DATA2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 6</td>
<td>Disk 12/13</td>
<td>I or /u07</td>
<td>AGILE_DATA3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 7</td>
<td>Disk 14/15</td>
<td>J or /u08</td>
<td>AGILE_DATA4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 8</td>
<td>Disk 16/17</td>
<td>K or /u09</td>
<td>AGILE_DATA1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Twelve-Disk Configuration

Further separating the AGILE_DATA and AGILE_INDX tablespaces, twelve-disk configurations can be implemented as shown in Table 1-10. This results in completely independent spindles for AGILE_DATA1, AGILE_DATA2, AGILE_DATA3, AGILE_DATA4 and AGILE_INDX1, AGILE_INDX2, AGILE_INDX3, AGILE_INDX4.

Table 1-10: Twelve-disk configuration for OFA Implementation with Mirroring

<table>
<thead>
<tr>
<th>Disks (no RAID)</th>
<th>Disks (RAID 1)</th>
<th>Drives/ Mount Points</th>
<th>Oracle_Home</th>
<th>Tablespaces</th>
<th>Redo Logfiles</th>
<th>Control files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk 0</td>
<td>Disk 0/1</td>
<td>C or /u01</td>
<td>Oracle_Home</td>
<td>SYSTEM/TOOL/UNDO/TEMP/INDX</td>
<td>Control file01</td>
<td></td>
</tr>
<tr>
<td>Disk 1</td>
<td>Disk 2/3</td>
<td>D or /u02</td>
<td></td>
<td>LOG 1/2/3/4</td>
<td>Control file02</td>
<td></td>
</tr>
<tr>
<td>Disk 2</td>
<td>Disk 4/5</td>
<td>E or /u03</td>
<td>USERS</td>
<td>Archive log file</td>
<td>Control file03</td>
<td></td>
</tr>
<tr>
<td>Disk 3</td>
<td>Disk 6/7</td>
<td>F or /u04</td>
<td>AGILE_DATA1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 4</td>
<td>Disk 8/9</td>
<td>G or /u05</td>
<td>AGILE_DATA2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 5</td>
<td>Disk 10/11</td>
<td>H or /u06</td>
<td>AGILE_DATA3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 6</td>
<td>Disk 12/13</td>
<td>I or /u07</td>
<td>AGILE_DATA4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 7</td>
<td>Disk 14/15</td>
<td>J or /u08</td>
<td>AGILE_INDX1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 8</td>
<td>Disk 16/17</td>
<td>K or /u09</td>
<td>AGILE_INDX2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 9</td>
<td>Disk 18/19</td>
<td>L or /u10</td>
<td>AGILE_INDX3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 10</td>
<td>Disk 20/21</td>
<td>M or /u11</td>
<td>AGILE_INDX4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk 11</td>
<td>Disk 22/23</td>
<td>N or /u12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 2

Installing the Agile Database on Windows

This chapter explains how to create the Agile database on Windows. It includes these topics:

- Installation Notes
- Copying the Agile CDs
- Installing the Oracle Database
- Starting the Installer
- Using the Agile Database Configuration Utility
- Adding and Configuring the Listener
- Configuring Oracle Database Control (Optional)

Installation Notes

For best results, as you install:

- Follow directions in the order in which they are given. Do not attempt to install any components out of sequence.
- Oracle passwords are not case-sensitive. Agile passwords are case-sensitive. All other text entries, such as schema names and folder names, are not case-sensitive. To avoid confusion, all passwords and text entries in this guide appear in lowercase and should be typed as shown.
- When prompted for a hostname, type the short name for the host, not the fully qualified name. For example, if a host is named dbo, type `dbo`, not `dbo.agile.com`.

Copying the Agile CDs

Before installing Agile PLM 9.2.1, the contents of both CDs should be copied to a local directory with the same file structure as the original CDs. The Platform directory on CD #2 must be copied on the same directory level as the setup.exe file.

Installing the Oracle Database

Use the instructions in Appendix A, “Installing Oracle 9i” to install Oracle 9i Release 2 or Appendix B, “Installing Oracle 10g” to install Oracle 10g Release 2, if the database is not already installed.

Starting the Installer

The installation of all components follows the same initial process up through the panel where you select the components to install.

Important To run the Agile installation program, you must have at least 1200MB of available disk space on Windows on the drive where your default Temp directory is located.

Note Disable virus protection, if you are using it. Components used in the installer can be falsely identified as being infected and lock up the installation. You can turn the virus protection on after the installation is complete.

To start the Agile PLM installer on Windows:

1. Log in to the computer using a login with local Administrator permissions.
2. In the Agile installation directory for Windows, double-click the `setup.exe` file.

Note If there is insufficient disk space available to complete the installation, you will be prompted for another location. Click Choose, select another drive, click OK, and the installer will start.

After a few moments, the Welcome screen appears.

During Agile PLM installation, you must select components to install. The list of components you can install is based on your license key. Choose Database Server and Agile PLM when this list displays to install and create the Agile database with the Agile Database Configuration Utility.

Installer Buttons

Agile PLM installation panels have the following buttons:

- **Cancel** — Exits from the installation program.
- **Help** — Displays online help.
- **Previous** — Returns to the previous step.
- **Next** — Proceeds to the next step.
❑ **Install** — Starts installing. The **Install** button appears only on the Pre-Installation Summary panel, after you have specified installation options.

❑ **Done** — Exits from the installation program. On Windows, after installing certain components you can choose whether to restart the computer when you click **Done**. The **Done** button appears only on the Install Complete panel, after you have finished installing.

**Installer Online Help**

Each installation panel has online help. At any time during installation, you can click **Help** for more information about the panel’s options.

If you leave the online help window open, it will be updated when you proceed through the installer panels. Otherwise, click **Close** at the bottom of the help window.

**Using the Agile Database Configuration Utility**

The Agile database configuration utility creates and configures the database used by Agile. The database configuration utility appears after you click **Install** in the Agile PLM installer.

**Notes**  
The installer creates and configures an Agile database using the default values.

All hard drive indicators show the available disk space. If the space is a negative value, you must select another hard drive.

**Important**  
If you change a default value, you must click in the field to ensure that the change is activated.

1 The Destination Location dialog box of the Database Configuration Utility appears. This is the location where files are placed during the database installation. You should accept the default location. Click **Next**.

The Database Size Estimate dialog box appears.

2 New Agile customers without an existing database to migrate should accept the default (**Small**). Click **Next**.

   **Note**  
   Refer to the *Capacity Planning and Deployment Guide* for database sizing information.

The Oracle Home dialog box appears. This is the location where the Oracle database files were installed.

If you have multiple Oracle Homes, make sure the correct Oracle Home is selected in the list before continuing with the Database Configuration Utility.

3 You should accept the default unless there is insufficient disk space available. Click **Next**.

The Oracle SID dialog box appears.

If you want to change the SID, you must use an ID less than or equal to 8 characters to uniquely identify the Oracle SID. If you want to use an existing SID, you must remove it before you can re-use it.

4 You should accept the default **agile9** SID. Click **Next**.

The Database Security and Agile User Information dialog box appears.

5 You should accept the default values as follows and then click **Next**.

   •  Sys Password is **oracle**
   •  System Password is **manager**
   •  Agile Schema Name is **agile**
   •  Agile Schema Password is **tartan**

The Tablespace dialog box appears.
6 You should accept the default, unless you have additional hard drives with sufficient space available that allow you to distribute the files across multiple hard drives. If you select a different drive location, click the letter of the drive to make sure it is selected. Click Next.

Note Use the tables in “Disk I/O Configurations” on page 1-5 to determine how to distribute the files.

The Redo Log Files dialog box appears.

7 You should accept the default, unless you have additional hard drives with sufficient space available that allow you to distribute the files across multiple hard drives. Click Next.

The Control Files dialog box appears.

8 You should accept the default, unless you have additional hard drives with sufficient space available that allow you to distribute the files across multiple hard drives. Click Next.

9 If you accept the default location for the files on one drive, a message appears notifying you about distributing the files across multiple drives (mirroring protection). If this is not an option, click Next. Otherwise, click Back and reassign files to different hard drives.

The Archive Log File dialog box appears.

10 You should accept the default, unless you have additional hard drives with sufficient space available that allow you to store the file on a different hard drive. Click Next.

The Oracle Language Support dialog box appears.

Note For additional information about language support, refer to the Oracle Globalization Support Guide.

11 The default character set is UTF8. Click Next.

A Command Prompt window displays briefly.

12 You are prompted to install the Agile database. Click Next.

The script runs in a Command Prompt window for awhile. The window automatically closes when the database is installed.

Important Change all Oracle database user passwords after you have created the Agile database. It is recommended to change these passwords periodically for security purposes.

Agile supports Full Text Search (FTS). FTS is a feature enabled through Oracle Text. Because of this feature, there is a fixed account, CTXSYS, and its schema used by the Agile schema. For security purposes, you can change the CTXSYS account password from its default, CTXSYS, to one of your choosing after Agile database creation and configuration.

Adding and Configuring the Listener

If this is the first time Oracle has been installed on the current computer, you need to add and configure a new address to the Listener settings.

If you are upgrading your Agile database on the same machine, you only need to add the new database to the existing listener.

To add a new Listener address on Oracle 9i:

1 Start the Oracle Net Configuration Assistant by choosing Start > Programs > Oracle -OraHome92 > Configuration and Migration Tools > Net Configuration Assistant.

2 In the Oracle Net Configuration Assistant window, select Listener Configuration. Click Next.

3 Select Add to add a listener to the database. Click Next.

4 Accept the default listener name, LISTENER, in the Listener Name dialog box. Click Next.

5 Accept TCP as the Selected Protocol. Click Next.
Chapter 2

Installing the Agile Database on Windows

6 Accept the standard port of 1521. Click Next.

7 Select No when asked to configure another listener. Click Next.

8 The Listener configuration is complete. Click Next.

9 Click Finish to close the Oracle Net Configuration Assistant window.

To configure the new Listener address on Oracle 9i:

1 Start the Oracle Net Manager by choosing Start > All Programs > Oracle - OraHome92 > Configuration and Migration Tools > Net Manager.

2 In the Oracle Net Manager window, double-click the Local folder and select the Listeners folder.

3 Click the name of the newly created listener, LISTENER.

4 Select Database Services in the Listening Locations drop-down list.
   a Click Add Database.
   b In the dialog box that appears, make the following changes:
      • Global Database Name: agile9
      • Oracle Home Directory: <Oracle_Home>
      • SID: agile9
      Note If you used a different global database name or different home directory during the database installation, change the information as appropriate.

5 Choose File > Save Network Configuration to save your changes.

To add and configure a new Listener address on Oracle 10g:

1 Start the Oracle Net Manager by choosing Start > All Programs > Oracle - OraDb10g_home1 > Configuration and Migration Tools > Net Manager.

2 In the Oracle Net Manager window, double-click the Local folder and select the Listeners folder.

3 Click Create in the toolbar to add a listener.
   The Choose Listener Name dialog box appears.

4 Click OK.

5 Select Database Services in the Listening Locations drop-down list.
   a Click Add Database.
   b In the dialog box that appears, make the following changes:
      • Global Database Name: agile9
      • Oracle Home Directory: <Oracle_Home>
      • SID: agile9
      Note If you used a different global database name or different home directory during the database installation, change the information as appropriate.

6 Choose File > Save Network Configuration to save your changes.

7 Open a Command Prompt window and type lsnrctl reload to restart the database listener.

Configuring Oracle Database Control (Optional)

In Oracle 10g, you can use Database Control to perform many database administration and management tasks including SQL performance tuning.
To configure the Oracle network connection:

1. Choose Start > All Programs > Oracle - OraDb10g-home1 > Configuration and Migration Tools > Database Configuration Assistant.
   The Welcome screen appears.

2. Click Next.

   The Database page appears.

4. Select the agile9 database you just created. Click Next.
   The Management Options page appears.

5. Check Configure the Database with Enterprise Manager. Click Next.
   The Database Content page appears.

6. Accept the defaults. Click Next.
   The Database Credentials page appears.

7. Enter a password for the DBSNMP and SYSMAN users. Click Next.
   The Connection Mode page appears.

8. Select Dedicated Server Mode. Click Finish.

9. Click OK for confirmation. Database configuration begins.

10. When configuration completes, the Database Control URL displays. Make a note of this URL because it is used to log in to the database.

11. Click OK to close the Database Configuration Assistant.

12. Open a web browser and enter the Database Control URL.

13. Type the User Name and Password of the Agile database. Click Login.

14. Click I agree to accept the license agreement and display the Database Control page.

You have finished installing and configuring the Agile PLM 9.2.1 database.
CHAPTER 3
Installing the Agile Database on Solaris

This chapter explains how to create the Agile database on Solaris. It includes these topics:

- Overview
- Preparing the Host Computer
- Creating the Agile Database
- Post-Installation Tasks

Important An Oracle database administrator should install this product.
Overview

This chapter provides information for installing Oracle and creating the Agile database on Solaris. Before you begin, make sure that you have reviewed all relevant Oracle documentation and ensured the computer meets the minimum system requirements.

Important For best results, start with a clean system (no previous versions of Oracle).

This chapter provides information for installing an Oracle database on Sun Solaris. The installation process consists of four major steps:

1. Preparing an installation environment.
2. Installing Oracle 9i Release 2 or Oracle 10g Release 2.
3. Running the Agile database scripts to create the Agile database.
4. Configuring Oracle network connectivity and setting additional Oracle functionality.

Oracle Source Documentation

Before you begin, it is important to be familiar with all the information about installing the Oracle database on Solaris, and with the Optimal Flexible Architecture (OFA) reference material for administrators. See the following Oracle documents:

  These documents are available on the Oracle Technology Network at http://otn.oracle.com/documentation/oracle9i.html.
- Oracle 10g Installation Guide Release 2 (10.2) for UNIX Systems: AIX-Based Systems, hp HP-UX PA-RISC (64-bit), hp Tru64 UNIX, Linux x86, and Solaris Operating System (SPARC)
- Oracle Database Administrator’s Guide 10g Release 2 (10.2)
  These documents are available on the Oracle Technology Network at http://www.oracle.com/technology/documentation/database10gR2.html.

  Note Agile has made every attempt to be OFA-compliant. Any deviation from OFA guidelines are noted.

System Requirements

Before installing Oracle, ensure that your system configuration meets the minimum hardware requirements. If you are using a stand-alone system or hosting multiple instances, consider using the recommended hardware requirements for the specific environment to ensure acceptable performance. For information on specific system requirements, see the Capacity Planning and Deployment Guide.

It is suggested that a Solaris system administrator and Oracle database administrator are available to monitor system activity and determine resource requirements.

Preparing the Host Computer

This section describes how to prepare the installation environment on Solaris, such as creating the necessary groups and user accounts.

  Note To avoid changing CDs during the installation, you should create an area containing the Oracle installation files.
To create the Oracle user account:

1. Log in to the system as root.
2. Create a home directory for the Oracle user:

   ```bash
   # mkdir -p /u01/oracle
   [Enter]
   ```
3. Create two groups called “oinstall” and “dba:

   ```bash
   # groupadd oinstall
   [Enter]
   # groupadd dba
   [Enter]
   ```
4. Create the Oracle user:

   ```bash
   # useradd -d /u01/oracle -s /bin/sh -g oinstall -G dba oracle
   [Enter]
   ```

   where:
   
   /u01/oracle is the Oracle user home directory
   /bin/sh is the Oracle user login shell
   oinstall is the primary group for the Oracle user
   dba is the secondary group for the Oracle user
5. Set the Oracle user password, and change the Oracle home file ownership:

   ```bash
   # passwd oracle
   [Enter]
   Enter password:
   # chown oracle:dba /u01/oracle
   [Enter]
   ```
6. Create the Oracle installation directory:

   ```bash
   # mkdir -p /u01/app/oracle
   [Enter]
   # chown oracle:oinstall /u01/app/oracle
   [Enter]
   ```

You must now copy the Agile database scripts.

To copy the Agile database utilities:

1. Change to the Oracle user, and create a temporary directory named “agile9tmp:”

   ```bash
   # su - oracle
   $ mkdir /u01/oracle/agile9tmp
   [Enter]
   ```
2. Insert the Agile installation CD, and copy the agile921db.tar.Z file from the installation CD to the agile9tmp directory:

   ```bash
   $ cd /cdrom
   [Enter]
   For Oracle 9i:$ cd /CD1_Agile/Solaris/DB/Oracle9i
   For Oracle 10g:$ cd /CD1_Agile/Solaris/DB/Oracle10g
   $ cp agile921db.tar.Z /u01/oracle/agile9tmp
   [Enter]
   ```
3. Change to the agile9tmp directory, and uncompress the files from the agile921db.tar.Z file:

   ```bash
   $ cd /u01/oracle/agile9tmp
   $ uncompress agile921db.tar.Z
   [Enter]
   ```
4. Extract the agile921db.tar file:

   ```bash
   $ tar -xvf agile921db.tar
   [Enter]
   ```

The agile921db.tar file contains the following files:

- agile9.sh — Bourne shell script for creating the database and schema
- agile9db.sh — Bourne shell script for creating the database maintenance script
- profile.txt — oracle user .profile template
- system.txt — system kernel parameters
- dbora — setup for the database automatic shutdown and startup
- agile9schema.dmp — schema dump file
To modify the system kernel parameters:

1. Change to the root user, and back up the /etc/system file:

   ```
   $ su - [Enter]
   # cp /etc/system /etc/system_save [Enter]
   ```

2. Verify the following /etc/system kernel parameters. If the parameters do not exist, go to the next step.

   ```
   set shmsys:shminfo_shmmax = 4294967295
   set shmsys:shminfo_shmmin = 1
   set shmsys:shminfo_shmmni = 100
   set shmsys:shminfo_shmseg = 10
   set semsys:seminfo_semmns = 1024
   set semsys:seminfo_semmni = 100
   set semsys:seminfo_semmsl = 500
   set semsys:seminfo_sempcm = 100
   set semsys:seminfo_semvmx = 32767
   set noexec_user_stack = 1 (Note: On Oracle 10g only)
   ```

   **Important** If you have been running the host computer as an Oracle database server, you have to check with your Solaris system administrator before changing these parameters. For these parameter settings, you can also refer to the Oracle documentation.

   **Note** Restart the computer if you modify the /etc/system file.

3. The previous kernel parameters are set in the distributed system.txt file. Append system.txt to /etc/system if this is the first time you are configuring the host computer as the database server.

   ```
   # cat /u01/oracle/agile9tmp/system.txt >> /etc/system
   ```

   **Note** Use `>>` to append. If you have accidentally used `>`, you need to recover the original /etc/system file by using `cp system_save system`.

4. Restart the system to make the new kernel configuration take effect.

   **Note** If you do not restart the system, the database creation will fail. You may need to check with your Solaris system administrator for support.

To set up Oracle environmental variables:

1. Log in to the system as the Oracle user.

2. Create the environmental parameter file .profile to include:

   ```
   PATH=$PATH:/usr/local/bin:/usr/ccs/bin:/usr/openwin/bin:/usr/bin/X11
   export PATH
   (Oracle 9i)ORACLE_HOME=/u01/app/oracle/product/9.2.0SE; export ORACLE_HOME
   (Oracle 10g)ORACLE_HOME=/u01/app/oracle/product/10.2.0/db_1; export ORACLE_HOME
   ORACLE_BASE=/u01/app/oracle; export ORACLE_BASE
   PATH=$PATH:$ORACLE_HOME/bin; export PATH
   ORACLE_SID=agile9; export ORACLE_SID
   TNS_ADMIN=/var/opt/oracle; export TNS_ADMIN
   NLS_LANG=American_America.UTF8; export NLS_LANG
   ```

3. The environmental parameters in the previous step are set in the distributed profile.txt file. If this is the first time you are configuring the host computer as a database server, copy the profile.txt file to .profile:

   ```
   $ cat agile9tmp/profile.txt > .profile [Enter]
   ```

4. Update the environmental setting:

   ```
   $ . ~/.profile [Enter]
   ```
Making the Oracle Installer Available

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the computer. Use the instructions in Appendix A, “Installing Oracle 9i” or Appendix B, “Installing Oracle 10g” to copy the data from the installation CDs.

Installing the Oracle Database

Use the instructions in Appendix A, “Installing Oracle 9i” or Appendix B, “Installing Oracle 10g” to install the Oracle database, if it is not already installed.

vxfs File System Support

On Solaris, Agile officially supports the native Solaris file system. To enable the vxfs file system for testing, remove the bold text as shown in the agile9.sh script:

```bash
space=`df -kFufs $dir | nawk '{getline;print $4/1024}'`
```

After modification, the line should appear as follows:

```bash
space=`df -k $dir | nawk '{getline;print $4/1024}'`
```

Creating the Agile Database

This section describes how to create the default database instance and schema used by Agile using the Agile database creation utility.

To start the installation:

1. Log in to the computer as the Oracle user.
   a. If necessary, edit the .profile file to change Oracle SID. By default, Agile uses agile9 as the Oracle SID:

   ```bash
   $ vi .profile
   [Enter]
   ```

   b. Modify the value where ORACLE_SID=agile9 by replacing agile9 with the SID you want to use.

   **Important** Check the /var/opt/oracle/oratab file and make sure that the specified Oracle SID has not been used. Specifying an existing Oracle SID can corrupt that database instance.

   **Note** Generally, the SID length is four alphanumeric characters. This avoids lengthy database filenames for associated database files.

   c. Run .profile to make the SID changes take effect:

   ```bash
   $. ./chmod u+x .profile
   [Enter]
   ```

2. In a second terminal session, log in to the computer as the root user.

3. Create a directory named “oradata.”

   **Note** The agile9.sh file uses a dummy mount point /mpt. You must change /mpt to match your mount points. For OFA compliance, it is highly recommended that you create at least four mount points (preferably on four different disks across multiple controllers) to optimize disk I/O.

   For example, if you have mount points at /u01 and /u02, you can create an oradata folder on each mount point.

   ```bash
   # mkdir -p /u01/oradata
   # chown oracle:dba /u01/oradata
   ```

4. In the session where you are logged in as the Oracle user, create a $ORACLE_BASE/admin directory:

   ```bash
   $ mkdir -p /u01/app/oracle/admin
   [Enter]
   ```
You must now run the agile9.sh script.

5  Change to the /u01/oracle/agile9tmp directory.

6  Modify the agile9.sh script to match the mount points on your computer, and then copy the script to the Oracle user home directory (/u01/oracle).

**Important** Make sure ORACLE_SID matches the one you set for .profile, which should have taken effect after you ran ./.profile.

**Note** The agile9.sh file uses a dummy mount point /mpt. You must change /mpt to match your mount points. For OFA compliance, it is highly recommended that you create at least four mount points (preferably on four different disks across multiple controllers) to optimize disk I/O.

The values in the script that can be modified appear in bold. You should limit your editing only to these bold values.

For example, if you have a mount point created at /u01, you can modify agile9.sh and quickly recreate it in the Oracle user home directory by issuing one command.

```
$ cat /u01/oracle/agile9tmp/agile9.sh | sed -e "s/mpt//u01//g" > /u01/oracle/agile9.sh
$ chmod u+x /u01/oracle/agile9.sh
```

Note: The following code list variable in bold that you may want to revise besides dummy mount point /mpt

```bash
#!/bin/sh
#
#  ==============================================================
#  Copyright (c) 1995-2005 Agile Software Corporation
#  All Rights Reserved.
#  ==============================================================
#
# Oracle_sid default as agile9
#
ORACLE_SID=agile9  # Oracle SID for the database
AASYSPW=oracle     # Oracle sys passwd for the database
AASYSTEMPW=manager # Oracle system passwd for the database
AGILE=agile        # Oracle account for AGILE schema
AGILEPW=tartan     # Oracle passwd for AGILE
#
# Parameters determine location of datafiles, controlfiles and logfiles
#
DATABASE_SYSTEM=/mpt/oradata/${ORACLE_SID}  # SYSTEM tablespace
DATABASE_TOOLS=/mpt/oradata/${ORACLE_SID}   # TOOLS tablespace
DATABASE_UNDO=/mpt/oradata/${ORACLE_SID}    # RBS tablespace
DATABASE_TEMP=/mpt/oradata/${ORACLE_SID}    # TEMP tablespace
DATABASE_USERS=/mpt/oradata/${ORACLE_SID}   # USERS tablespace
DATABASE_INDEX=/mpt/oradata/${ORACLE_SID}   # INDEX tablespace
DATABASE_AGILE_DATA1=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDEX1=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_DATA2=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDEX2=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_DATA3=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDEX3=/mpt/oradata/${ORACLE_SID}
```
Chapter 3  Installing the Agile Database on Solaris

DATABASE_AGILE_DATA4=/mnt/oradata/$(ORACLE_SID)
DATABASE_AGILE_INDEX4=/mnt/oradata/$(ORACLE_SID)
DATABASE_LOGFILES1=/mnt/oradata/$(ORACLE_SID)  # REDOLOG file 1
DATABASE_LOGFILES2=/mnt/oradata/$(ORACLE_SID)  # REDOLOG file 2
DATABASE_LOGFILES3=/mnt/oradata/$(ORACLE_SID)  # REDOLOG file 3
DATABASE_LOGFILES4=/mnt/oradata/$(ORACLE_SID)  # REDOLOG file 4
DATABASE_CONTROL1=/mnt/oradata/$(ORACLE_SID)  # CONTROL file 1
DATABASE_CONTROL2=/mnt/oradata/$(ORACLE_SID)  # CONTROL file 2
DATABASE_CONTROL3=/mnt/oradata/$(ORACLE_SID)  # CONTROL file 3
DATABASE_ARCHIVE=/mnt/oradata/$(ORACLE_SID)/arch  # ARCHIVELOGS
#
# Parameters determine character set used
#
CHARACTER_SET=UTF8
NATIONAL_CHARACTER_SET=UTF8

7 Run the agile9.sh script from the Oracle user home directory:

$ cd
$ cp agile9tmp/agile9schema.dmp .
$ ./agile9.sh

Note   If you are unable to create files, you may have to give the system user full privileges to the u01 directory.

8 You are prompted about the database size that you want to install.

You should use the regular database size unless you have consulted with an Agile Solutions Consultant or
database administrator to ensure that the computer meets the minimum requirements for the specified database
size.

The script will run for awhile.

Important   Change all Oracle database user passwords after you have created the Agile database. It is recommended
to change these passwords periodically for security purposes.

Continue to the next section for post-installation tasks.

Post-Installation Tasks

This section describes how to configure Oracle Net Manager, and set the automatic startup and shutdown features
for the database.

Setting Up Oracle Net Manager

To set up Oracle Net Manager:

If you use the TNS_ADMIN environment variable to specify the location of Oracle Network Services configuration
files (such as tnsnames.ora), move the files located in the $ORACLE_HOME/network/admin directory to the
directory specified by TNS_ADMIN.

1 Log in as root and change the ownership of the /var/opt/oracle directory:

   # chown -R oracle:dba /var/opt/oracle [Enter]

2 Switch to the Oracle user, and change to the $ORACLE_HOME/network/admin network directory:

   # su - oracle [Enter]
   $ cd $ORACLE_HOME/network/admin [Enter]

3 Move all the files to the directory defined by environmental parameter TNS_ADMIN, which is /var/opt/oracle:

   $ mv * /var/opt/oracle [Enter]
Setting Up Automatic Shutdown and Startup for the Database

To set up the Oracle database to automatically shut down and start up when the host computer starts up and shuts down:

1. Log in the system as `root`.
2. Create a file named “dbora” in the /etc/init.d directory:
   ```
   # cat /u01/oracle/agile9tmp/dbora > /etc/init.d/dbora
   [Enter]
   ```
3. Link to the dbora file:
   ```
   # ln -s /etc/init.d/dbora /etc/rc0.d/K10dbora
   [Enter]
   # ln -s /etc/init.d/dbora /etc/rc2.d/S99dbora
   [Enter]
   ```

Configuring the listener.ora File

If you are upgrading your Agile database on the same machine, you only need to add the new database to the existing listener.

To configure the listener.ora file:

1. Start Net Manager:
   ```
   $ netmgr &
   ```
2. Within the `Local` folder, open the `Listeners` folder and select `LISTENER`.
   Check to see if the following settings appear in one of the `Address` tabs:
   - Protocol: TCP/IP
   - Host: the host computer where the Oracle database is installed
   - Port: 1521
   - If the information does not appear, click `Add Address`.
     A new `Address` tab appears.
   - Type these settings:
     - Protocol: TCP/IP
     - Host: the host computer where the Oracle database is installed
     - Port: 1521
   - Select `Database Service` in the `Listener Location` drop-down list.
   - Click `Add Database`.
     In the dialog box that appears, make the following changes:
     - Global Database Name: `agile9`
     - Oracle Home Directory: `Oracle_Home`
     - SID: `agile9`
   - Choose `File > Save Network Configuration` to save your changes.

3. Close Net Manager.

Configuring the tnsnames.ora File (Optional)

1. In the Oracle Net Manager window, double-click the `Local` folder and select the `Service Naming` folder.
2. Click `Create` in the toolbar to add a service name.
   The Net Service Name Wizard starts.
3. In the `Net Service Name` field, type the name of the computer where the Oracle database is located (usually the current computer). Click `Next`.

3-8 Agile PLM Database Installation Guide
You are prompted to select a network protocol. Select **TCP/IP (Internet Protocol)** and click **Next**.

Type the name of the computer where Oracle is located in the **Hostname** field (the same name you typed in step 3). Accept **1521** as the default port number. Click **Next**.

Select **Oracle8i or later** as the service name, and type **agile9** in the field. Click **Next**.

Click **Test** to test the service.

The test initially fails because the default uses the incorrect login.

Click **Change Login** to reset the username and password.

Type **agile** in the **Username** field and **tartan** in the **Password** field. Click **OK**.

Click **Test**.

You should now see a message indicating that the test was successful.

Click **Close**.

Click **Finish** to exit the Net Service Name Wizard.

From the Net Manager menu, choose **File > Save Network Configuration** to save the service name.

This completes the installation and configuration for Oracle on Solaris.
CHAPTER 4

Installing the Agile Database on Linux

This chapter explains how to create the Agile database on Linux. It includes these topics:

- Overview
- Preparing the Host Computer
- Creating the Agile Database
- Post-Installation Tasks

Important  An Oracle database administrator should install this product.
Overview

This chapter provides information for installing Oracle and creating the Agile database on Linux. Before you begin, make sure that you have reviewed all relevant Oracle documentation and ensured the computer meets the minimum system requirements.

Important For best results, start with a clean system (no previous versions of Oracle).

This chapter provides information for installing an Oracle database on RedHat Enterprise Linux 4. The installation process consists of four major steps:

1. Preparing an installation environment.
2. Installing Oracle 10g Release 2.
3. Running the Agile database scripts to create the Agile database.
4. Configuring Oracle network connectivity and setting additional Oracle functionality.

Oracle Source Documentation

Before you begin, it is important to be familiar with all the information about installing the Oracle database on Linux, and with the Optimal Flexible Architecture (OFA) reference material for administrators. See the following Oracle documents:

- Oracle 10g Installation Guide Release 2 (10.2) for UNIX Systems: AIX-Based Systems, hp HP-UX PA-RISC (64-bit), hp Tru64 UNIX, Linux x86, and Solaris Operating System (SPARC)
- Oracle Database Administrator’s Guide 10g Release 2 (10.2)

These documents are available on the Oracle Technology Network at http://www.oracle.com/technology/documentation/database10gR2.html.

Note Agile has made every attempt to be OFA-compliant. Any deviation from OFA guidelines are noted.

System Requirements

Before installing Oracle, ensure that your system configuration meets the minimum hardware requirements. If you are using a stand-alone system or hosting multiple instances, consider using the recommended hardware requirements for the specific environment to ensure acceptable performance. For information on specific system requirements, see the Capacity Planning and Deployment Guide.

It is suggested that a system administrator and Oracle database administrator are available to monitor system activity and determine resource requirements.

Preparing the Host Computer

This section describes how to prepare the installation environment on Linux, such as creating the necessary groups and user accounts.

Note To avoid changing CDs during the installation, you should create an area containing the Oracle installation files.

To create the Oracle user account:

1. Log in to the system as root.
2. Create a home directory for the Oracle user:
   
   ```
   # mkdir -p /u01/oracle
   # Enter
   ```
3. Create two groups called “oinstall” and “dba:”
   
   ```
   # groupadd oinstall
   # groupadd dba
   # Enter
   ```
4-3

Chapter 4 Installing the Agile Database on Linux

# groupadd dba  [Enter]

4 Create the Oracle user:

    # useradd -d /u01/oracle -s /bin/sh -g
    oinstall -G dba oracle  [Enter]

where:

/u01/oracle is the Oracle user home directory
/bin/sh is the Oracle user login shell
oinstall is the primary group for the Oracle user
dba is the secondary group for the Oracle user

5 Set the Oracle user password, and change the Oracle home file ownership:

    # passwd oracle  [Enter]
    Enter password:
    # chown oracle:dba /u01/oracle  [Enter]

6 Create the Oracle installation directory:

    # mkdir -p /u01/app/oracle  [Enter]
    # chown oracle:oinstall /u01/app/oracle  [Enter]

You must now copy the Agile database scripts.

To copy the Agile database utilities:

1 Change to the Oracle user, and create a temporary directory named “agile9tmp:”

    # su - oracle  [Enter]
    $ mkdir /u01/oracle/agile9tmp  [Enter]

2 Insert the Agile installation CD, and copy the agile921db.tar.Z file from the installation CD to the agile9tmp directory:

    $ cd /cdrom  [Enter]
    $ cd /CD1_Agile/Linux/DB/Oracle10g
    $ cp agile921db.tar.Z /u01/oracle/agile9tmp  [Enter]

3 Change to the agile9tmp directory, and uncompress the files from the agile921db.tar.Z file:

    $ cd /u01/oracle/agile9tmp  [Enter]
    $ gunzip agile921db.tar.gz  [Enter]

4 Extract the agile921db.tar file:

    $ tar -xvf agile921db.tar  [Enter]

The agile921db.tar file contains the following files:

- agile9.sh — Bourne shell script for creating the database and schema
- agile9db.sh — Bourne shell script for creating the database maintenance script
- profile.txt — oracle user .profile template
- system.txt — system kernel parameters
- dbora — setup for the database automatic shutdown and startup
- agile9schema.dmp — schema dump file

To set up Oracle environmental variables:

1 Log in to the system as the Oracle user.

2 Create the environmental parameter file .profile to include:

    PATH=$PATH:/usr/local/bin:/usr/ccs/bin:/usr/openwin/bin:/usr/bin/X11
    export PATH
    ORACLE_HOME=/u01/app/oracle/product/10.2.0/db_1; export ORACLE_HOME
    ORACLE_BASE=/u01/app/oracle; export ORACLE_BASE
PATH=$PATH:$ORACLE_HOME/bin; export PATH
ORACLE_SID=agile9; export ORACLE_SID
TNS_ADMIN=/var/opt/oracle; export TNS_ADMIN
NLS_LANG=American_America.UTF8; export NLS_LANG

Note Make sure the ORACLE_HOME and ORACLE_BASE entries contain the correct directory paths.

3 The environmental parameters in the previous step are set in the distributed profile.txt file. If this is the first time you are configuring the host computer as a database server, copy the profile.txt file to .profile:

$ cat agile9tmp/profile.txt > .profile [Enter]

4 Update the environmental setting:

$ . ./chmod u+x .profile [Enter]

Making the Oracle Installer Available

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the computer. Use the instructions in Appendix B, “Installing Oracle 10g” to copy the data from the installation CDs.

Installing the Oracle Database

Use the instructions in Appendix B, “Installing Oracle 10g” to install the Oracle database, if it is not already installed.

Creating the Agile Database

This section describes how to create the default database instance and schema used by Agile using the Agile database creation utility.

To start the installation:

1 Log in to the computer as the Oracle user.

   a If necessary, edit the .profile file to change Oracle SID. By default, Agile uses agile9 as the Oracle SID:

      $ vi .profile [Enter]

   b Modify the value where ORACLE_SID=agile9 by replacing agile9 with the SID you want to use.

   Important Check the /var/opt/oracle/oratab file and make sure that the specified Oracle SID has not been used. Specifying an existing Oracle SID can corrupt that database instance.

   Note Generally, the SID length is four alphanumeric characters. This avoids lengthy database filenames for associated database files.

   c Run .profile to make the SID changes take effect:

      $ . ./chmod u+x .profile [Enter]

2 In a second terminal session, log in to the computer as the root user.

3 Create a directory named “oradata.”

   Note The agile9.sh file uses a dummy mount point /mpt. You must change /mpt to match your mount points. For OFA compliance, it is highly recommended that you create at least four mount points (preferably on four different disks across multiple controllers) to optimize disk I/O.

   For example, if you have mount points at /u01 and /u02, you can create an oradata folder on each mount point.

      # mkdir -p /u01/oradata
      # chown oracle:dba /u01/oradata

4 In the session where you are logged in as the Oracle user, create a $ORACLE_BASE/admin directory:
$ mkdir -p /u01/app/oracle/admin  [Enter]

You must now run the agile9.sh script.

5 Change to the /u01/oracle/agile9tmp directory.

6 Modify the agile9.sh script to match the mount points on your computer, and then copy the script to the Oracle user home directory (/u01/oracle).

**Important** Make sure ORACLE_SID matches the one you set for .profile, which should have taken effect after you ran ./.profile.

**Note** The agile9.sh file uses a dummy mount point /mpt. You must change /mpt to match your mount points. For OFA compliance, it is highly recommended that you create at least four mount points (preferably on four different disks across multiple controllers) to optimize disk I/O.

The values in the script that can be modified appear in bold. You should limit your editing only to these bold values.

For example, if you have a mount point created at /u01, you can modify agile9.sh and quickly recreate it in the Oracle user home directory by issuing one command.

$ cat /u01/oracle/agile9tmp/agile9.sh | sed -e "s/mpt//u01\//g" > /u01/oracle/agile9.sh
$ chmod u+x /u01/oracle/agile9.sh

**Note:** The following code lists variable in bold that you may want to revise besides dummy mount point /mpt

```bash
#!/bin/sh
#
#  =========================================================
#  Copyright (c) 1995-2005 Agile Software Corporation
#  All Rights Reserved.
#
#  This is unpublished proprietary source code of Agile
#  Software Corporation. The copyright notice above
#  does not evidence any actual or intended publication of
#  such source code.
#  =========================================================================
#
#  Oracle_sid default as agile9
#
ORACLE_SID=agile9  # Oracle SID for the database
AASYSPW=oracle     # Oracle sys passwd for the database
AASYSTEMPW=manager # Oracle system passwd for the database
AGILE=agile        # Oracle account for AGILE schema
AGILEPW=tartan     # Oracle passwd for AGILE
#
# Parameters determine location of datafiles,
# controlfiles and logfiles
#
DATABASE_SYSTEM=/mpt/oradata/${ORACLE_SID}  # SYSTEM tablespace
DATABASE_TOOLS=/mpt/oradata/${ORACLE_SID}  # TOOLS tablespace
DATABASE_UNDO=/mpt/oradata/${ORACLE_SID}  # RBS tablespace
DATABASE_TEMP=/mpt/oradata/${ORACLE_SID}  # TEMP tablespace
DATABASE_USERS=/mpt/oradata/${ORACLE_SID}  # USERS tablespace
DATABASE_INDEX=/mpt/oradata/${ORACLE_SID}  # INDX tablespace
DATABASE_AGILE_DATA1=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDEX1=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_DATA2=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDEX2=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_DATA3=/mpt/oradata/${ORACLE_SID}
```
Run the agile9.sh script from the Oracle user home directory:

```bash
$ cd
$ cp agile9tmp/agile9schema.dmp .
$ ./agile9.sh
```

**Note** If you are unable to create files, you may have to give the system user full privileges to the u01 directory.

You are prompted about the database size that you want to install.

You should use the regular database size unless you have consulted with an Agile Solutions Consultant or database administrator to ensure that the computer meets the minimum requirements for the specified database size.

The script will run for awhile.

**Important** Change all Oracle database user passwords after you have created the Agile database. It is recommended to change these passwords periodically for security purposes.

Continue to the next section for post-installation tasks.

### Post-Installation Tasks

This section describes how to configure Oracle Net Manager, and set the automatic startup and shutdown features for the database.

### Setting Up Oracle Net Manager

To set up Oracle Net Manager:

If you use the TNS_ADMIN environment variable to specify the location of Oracle Network Services configuration files (such as tnsnames.ora), move the files located in the $ORACLE_HOME/network/admin directory to the directory specified by TNS_ADMIN.

1. Log in as `root` and change the ownership of the /var/opt/oracle directory:

   ```bash
   # chown -R oracle:dba /var/opt/oracle
   # su - oracle
   $ cd $ORACLE_HOME/network/admin
   # mv * /var/opt/oracle
   ```
Setting Up Automatic Shutdown and Startup for the Database

To set up the Oracle database to automatically shut down and start up when the host computer starts up and shuts down:

1. Log in the system as root.
2. Create a file named “dbora” in the /etc/init.d directory:
   ```
   # cat /u01/oracle/agile9tmp/dbora > /etc/init.d/dbora
   ```
3. Link to the dbora file:
   ```
   # ln -s /etc/init.d/dbora /etc/rc0.d/K10dbora
   # ln -s /etc/init.d/dbora /etc/rc2.d/S99dbora
   ```

Configuring the listener.ora File

To configure the listener.ora file:

1. Start Net Manager:
   ```
   $ netmgr &
   ```
2. Within the Local folder, open the Listeners folder and select LISTENER.
   Check to see if the following settings appear in one of the Address tabs:
   
   - **Protocol**: TCP/IP
   - **Host**: the host computer where the Oracle database is installed
   - **Port**: 1521

   a. If the information does not appear, click Add Address.
      A new Address tab appears.
   b. Type these settings:
      ```
      Protocol: TCP/IP
      Host: the host computer where the Oracle database is installed
      Port: 1521
      ```
   c. Select Database Service in the Listener Location drop-down list.
   d. Click Add Database.
      In the dialog box that appears, make the following changes:
      ```
      Global Database Name: agile9
      Oracle Home Directory: Oracle_Home
      SID: agile9
      ```
3. Choose File > Save Network Configuration to save your changes.
Configuring the tnsnames.ora File (Optional)

1. In the Oracle Net Manager window, double-click the Local folder and select the Service Naming folder.

2. Click Create in the toolbar to add a service name.

   The Net Service Name Wizard starts.

3. In the Net Service Name field, type the name of the computer where the Oracle database is located (usually the current computer). Click Next.

4. You are prompted to select a network protocol. Select TCP/IP (Internet Protocol) and click Next.

5. Type the name of the computer where Oracle is located in the Hostname field (the same name you typed in step 3). Accept 1521 as the default port number. Click Next.

6. Select Oracle8i or later as the service name, and type agile9 in the field. Click Next.

7. Click Test to test the service.

   The test initially fails because the default uses the incorrect login.

8. Click Change Login to reset the username and password.

9. Type agile in the Username field and tartan in the Password field. Click OK.

10. Click Test.

    You should now see a message indicating that the test was successful.

11. Click Close.

12. Click Finish to exit the Net Service Name Wizard.

13. From the Net Manager menu, choose File > Save Network Configuration to save the service name.

This completes the installation and configuration for Oracle on Linux.
This chapter explains how to create the Product Interchange database on Windows. It includes these topics:

- Installation Notes
- Copying the Agile CDs
- Installing the Oracle Database
- Starting the Installer
- Agile PLM Components
- Using the Product Interchange Database Customization Utility
- Adding and Configuring the Listener
- Configuring Oracle Database Control (Optional)

**Note** Unless specified otherwise, all references to Windows specifically require Windows 2003 with Service Pack 2. Service Packs are available on Microsoft’s Web site, [www.microsoft.com](http://www.microsoft.com).
Installation Notes

For best results, as you install:

- Follow directions in the order in which they are given. Do not attempt to install any components out of sequence.
- Oracle passwords are not case-sensitive. Agile passwords are case-sensitive. All other text entries, such as schema names and folder names, are not case-sensitive. To avoid confusion, all passwords and text entries in this guide appear in lowercase and should be typed as shown.
- When prompted for a hostname, type the short name for the host, not the fully qualified name. For example, if a host is named dbo, type `dbo`, not `dbo.agile.com`.

Copying the Agile CDs

Before installing Agile PLM 9.2.1, the contents of both CDs should be copied to a local directory with the same file structure as the original CDs. The Platform directory on CD #2 must be copied on the same directory level as the setup.exe file.

Installing the Oracle Database

The Product Interchange database is supported on Oracle 9i Release 2 and Oracle 10g Release 2. Use the instructions in Appendix A, “Installing Oracle 9i” to install Oracle 9i Release 2 or Appendix B, “Installing Oracle 10g” to install Oracle 10g Release 2.

Starting the Installer

The installation of all components follows the same initial process up through the panel where you select the components to install.

Important

To run the Agile installation program, you must have at least 1200MB of available disk space on Windows on the drive where your default Temp directory is located.

Note

Disable virus protection, if you are using it. Components used in the installer can be falsely identified as being infected and lock up the installation. You can turn the virus protection on after the installation is complete.

To start the Agile PLM installer on Windows:

1. Log in to the computer using a login with local Administrator permissions.
2. In the Agile installation directory for Windows, double-click the `setup.exe` file.

Note

If there is insufficient disk space available to complete the installation, you will be prompted for another location. Click Choose, select another drive, click OK, and the installer will start.

After a few moments, the Welcome screen appears.

Installer Buttons

Agile PLM installation panels have the following buttons:

- **Cancel** — Exits from the installation program.
- **Help** — Displays online help.
- **Previous** — Returns to the previous step.
- **Next** — Proceeds to the next step.
- **Install** — Starts installing. The **Install** button appears only on the Pre-Installation Summary panel, after you have specified installation options.
Done — Exits from the installation program. On Windows, after installing certain components you can choose whether to restart the computer when you click Done. The Done button appears only on the Install Complete panel, after you have finished installing.

**Installer Online Help**

Each installation panel has online help. At any time during installation, you can click Help for more information about the panel’s options.

If you leave the online help window open, it will be updated when you proceed through the installer panels. Otherwise, click Close at the bottom of the help window.

**Agile PLM Components**

During Agile PLM installation, you must select components to install. The list of components you can install is based on your license key. Choose Database Server and Product Interchange when this list displays to install and create the Product Interchange database schema.

**Using the Product Interchange Database Customization Utility**

You will now use the Product Interchange database configuration utility to create and configure the database. The database customization utility appears after you click Install in the Agile PLM installer.

Notes The installer creates and configures an Agile Product Interchange database using the default values.

All hard drive indicators show the available disk space. If the space is a negative value, you must select another hard drive.

Important If you change a default value, you must click in the field to ensure that the change is activated.

1 The Destination Location dialog box of the Database Customization Utility appears. This is the location where files are placed during the database installation. You should accept the default location. Click Next.

The Database Size Estimate dialog box appears.

2 New Agile customers without an existing database to migrate should accept the default (Small). Click Next.

The Oracle Home dialog box appears. This is the location where the Oracle database files were installed.

3 You should accept the default unless there is insufficient disk space available. Click Next.

The Oracle SID dialog box appears.

If you want to change the SID, you must use a 4-character ID to uniquely identify the Oracle SID. If you want to use an existing SID, you must remove it before you can re-use it.

4 You should accept the default pidb SID. Click Next.

The Database Security and Agile User Information dialog box appears.

5 You should accept the default values or change to the values specific to your system, then click Next.

- Internal/Sys Password is oracle
- System Password is manager
- Product Interchange Schema Password is piuser
- Dralasoft Workflow User Password is dwe

The Tablespaces dialog box appears.

6 You should accept the default, unless you have additional hard drives with sufficient space available that allow you to distribute the files across multiple hard drives. Click Next.
The Redo Log Files dialog box appears.

7 You should accept the default, unless you have additional hard drives with sufficient space available that allow you to distribute the files across multiple hard drives. Click Next.

The Control Files dialog box appears.

8 You should accept the default, unless you have additional hard drives with sufficient space available that allow you to distribute the files across multiple hard drives. Click Next.

9 If you accept the default location for the files on one drive, a message appears notifying you about distributing the files across multiple drives (mirroring protection). If this is not an option, click Next. Otherwise, click Back and reassign files to different hard drives.

The Archive Log File dialog box appears.

10 You should accept the default, unless you have additional hard drives with sufficient space available that allow you to store the file on a different hard drive. Click Next.

The Oracle Language Support dialog box appears.

Note For additional information about language support, refer to the Oracle Globalization Support Guide.

11 The default character set is UTF8. Click Next.

A Command Prompt window displays briefly.

12 You are prompted to install the Product Interchange database. Click Next.

The script runs in a Command Prompt window for awhile. The window automatically closes when the database is installed.

Adding and Configuring the Listener

If this is the first time Oracle has been installed on the current computer, you need to add and configure a new address to the Listener settings.

To add a new Listener address on Oracle 9i:

1 Start the Oracle Net Configuration Assistant by choosing Start > All Programs > Oracle -OraHome92 > Configuration and Migration Tools > Net Configuration Assistant.

2 In the Oracle Net Configuration Assistant window, select Listener Configuration. Click Next.

3 Select Add to add a listener to the database. Click Next.

4 Accept the default listener name, LISTENER, in the Listener Name dialog box. Click Next.

5 Accept TCP as the Selected Protocol. Click Next.

6 Accept the standard port of 1521. Click Next.

7 Select No when asked to configure another listener. Click Next.

8 The Listener configuration is complete. Click Next.

9 Click Finish to close the Oracle Net Configuration Assistant window.

To configure the new Listener address on Oracle 9i:

1 Start the Oracle Net Manager by choosing Start > All Programs > Oracle - OraHome92 > Configuration and Migration Tools > Net Manager.

2 In the Oracle Net Manager window, double-click the Local folder and select the Listeners folder.

3 Click the name of the newly created listener, LISTENER.
4 Select **Database Services** in the **Listening Locations** drop-down list.
   a Click **Add Database**.
   b In the dialog box that appears, make the following changes:
      • **Global Database Name**: `pidb`
      • **Oracle Home Directory**: `d:\oracle\ora92`
      • **SID**: `pidb`
      **Note** If you used a different global database name or different home directory during the database installation, change the information as appropriate.

5 Choose **File > Save Network Configuration** to save your changes.

To add and configure a new Listener address on Oracle 10g:

1 Start the Oracle Net Manager by choosing **Start > All Programs > Oracle - OraDb10g_home1 > Configuration and Migration Tools > Net Manager**.
2 In the Oracle Net Manager window, double-click the **Local** folder and select the **Listeners** folder.
3 Click **Create** in the toolbar to add a listener.
   The Choose Listener Name dialog box appears.
4 Click **OK**.
5 Select **Database Services** in the **Listening Locations** drop-down list.
   a Click **Add Database**.
   b In the dialog box that appears, make the following changes:
      • **Global Database Name**: `pidb`
      • **Oracle Home Directory**: `<Oracle_Home>`
      • **SID**: `pidb`
      **Note** If you used a different global database name or different home directory during the database installation, change the information as appropriate.
6 Choose **File > Save Network Configuration** to save your changes.
7 Open a Command Prompt window and type `lsnrctl reload` to restart the database listener.

**Configuring Oracle Database Control (Optional)**

In Oracle 10g, you can use Database Control to perform many database administration and management tasks including SQL performance tuning.

To configure Oracle database control:

1 Choose **Start > All Programs > Oracle - OraDb10g-home1 > Configuration and Migration Tools > Database Configuration Assistant**.
   The Welcome screen appears.
2 Click **Next**.
3 Choose **Configure Database Options** on the Operations page. Click **Next**.
   The Database page appears
4 Select the `pidb` database you just created. Click **Next**.
   The Management Options page appears.
5 Check **Configure the Database with Enterprise Manager**. Click **Next**.
The Database Content page appears.

6 Accept the defaults. Click **Next**.

The Database Credentials page appears.

7 Enter a password for the DBSNMP and SYSMAN users. Click **Next**.

The Connection Mode page appears.

8 Select **Dedicated Server Mode**. Click **Next**.

9 Click OK for confirmation. Database configuration begins.

10 When configuration completes, the Database Control URL displays. Make a note of this URL because it is used to log in to the database.

11 Click **Finish** to close the Database Configuration Assistant.

12 Open a web browser and enter the Database Control URL.

13 Type the User Name and Password of the Product Interchange database. Click **Login**.

14 Click **I agree** to accept the license agreement and display the Database Control page.

You have finished installing and configuring the Product Interchange database.
This chapter explains how to create the Product Interchange database on Solaris. It includes these topics:

- Overview
- Preparing the Host Computer
- Creating the Product Interchange Database
- Post-Installation Tasks

Important  An Oracle database administrator should install this product.
Overview

This chapter provides information for installing Oracle and creating the Product Interchange database on Solaris. Before you begin, make sure that you have reviewed all relevant Oracle documentation and ensured the computer meets the minimum system requirements.

Important For best results, start with a clean system (no previous versions of Oracle).

This chapter provides information for installing an Oracle database on Sun Solaris. The installation process consists of four major steps:

1. Preparing an installation environment.
2. Installing Oracle 9i Release 2 or Oracle 10g Release 2.
3. Running the Product Interchange database scripts to create the database.
4. Configuring Oracle network connectivity and setting additional Oracle functionality.

Oracle Source Documentation

Before you begin, it is important to be familiar with all the information about installing the Oracle database on Solaris, and with the Optimal Flexible Architecture (OFA) reference material for administrators. See the following Oracle documents:

  These documents are available on the Oracle Technology Network at http://otn.oracle.com/documentation/oracle9i.html.
- Oracle 10g Installation Guide Release 2 (10.2) for UNIX Systems: AIX-Based Systems, hp HP-UX PA-RISC (64-bit), hp Tru64 UNIX, Linux x86, and Solaris Operating System (SPARC)
- Oracle Database Administrator’s Guide 10g Release 2 (10.2)
  These documents are available on the Oracle Technology Network at http://www.oracle.com/technology/documentation/database10gR2.html.
  Note Agile has made every attempt to be OFA-compliant. Any deviation from OFA guidelines are noted.

System Requirements

Before installing Oracle, ensure that your system configuration meets the minimum hardware requirements. If you are using a stand-alone system or hosting multiple instances, consider using the recommended hardware requirements for the specific environment to ensure acceptable performance. For information on specific system requirements, see the Capacity Planning and Deployment Guide.

It is suggested that a Solaris system administrator and Oracle database administrator are available to monitor system activity and determine resource requirements.

Preparing the Host Computer

This section describes how to prepare the installation environment on Solaris, such as creating the necessary groups and user accounts.

Note To avoid changing CDs during the installation, you should create an area containing the Oracle installation files.
To create the Oracle user account:

1. Log in to the system as root.
2. Create a home directory for the Oracle user:
   
   ```
   # mkdir -p /u01/oracle [Enter]
   ```
3. Create two groups called “oinstall” and “dba:”
   
   ```
   # groupadd oinstall [Enter]
   # groupadd dba [Enter]
   ```
4. Create the Oracle user:
   
   ```
   # useradd -d /u01/oracle -s /bin/sh -g oinstall -G dba oracle [Enter]
   ```

   where:
   - /u01/oracle is the Oracle user home directory
   - /bin/sh is the Oracle user login shell
   - oinstall is the primary group for the Oracle user
   - dba is the secondary group for the Oracle user
5. Set the Oracle user password, and change the Oracle home file ownership:
   
   ```
   # passwd oracle [Enter]
   Enter password:
   # chown oracle:dba /u01/oracle [Enter]
   ```
6. Create the Oracle installation directory:
   
   ```
   # mkdir -p /u01/app/oracle [Enter]
   # chown oracle:oinstall /u01/app/oracle [Enter]
   ```

   You must now copy the database scripts.

To copy the Product Interchange database utilities:

1. Change to the Oracle user, and create a temporary directory named “agilepitmp:”
   
   ```
   # su - oracle [Enter]
   $ mkdir /u01/oracle/agilepitmp [Enter]
   ```
2. Insert the Agile installation CD, and copy the pidb.tar.Z file from the installation CD to the agilepitmp directory:
   
   ```
   $ cd /cdrom [Enter]
   For Oracle 9i:$ cd /CD1_Agile/Solaris/DB/Oracle9i
   For Oracle 10g:$ cd /CD1_Agile/Solaris/DB/Oracle10g
   $ cp pidb.tar.Z /u01/oracle/agilepitmp [Enter]
   ```
3. Change to the agilepitmp directory, and uncompress the files from the pidb.tar.Z file:
   
   ```
   $ cd /u01/oracle/agilepitmp [Enter]
   $ uncompress pidb.tar.Z [Enter]
   ```
4. Extract the pidb.tar file:
   
   ```
   $ tar -xvf pidb.tar [Enter]
   ```

   The pidb.tar file contains the following files:

   - pidb.sh — Bourne shell script for creating the database and schema
   - profile.txt — oracle user .profile template
   - system.txt — system kernel parameters
   - dbora — setup for the database automatic shutdown and startup
   - agilepischema.dmp — schema dump file
To modify the system kernel parameters:

1. Change to the root user, and back up the /etc/system file:

   ```
   $ su - [Enter]
   # cp /etc/system /etc/system_save [Enter]
   ``

2. Verify the following /etc/system kernel parameters. If the parameters do not exist, go to the next step.

   ```
   set shmsys:shminfo_shmmax = 4294967295
   set shmsys:shminfo_shmmin = 1
   set shmsys:shminfo_shmmni = 100
   set shmsys:shminfo_shmseg = 10
   set semsys:seminfo_semmns = 1024
   set semsys:seminfo_semmni = 100
   set semsys:seminfo_semmseg = 500
   set semsys:seminfo_semmom = 100
   set semsys:seminfo_semvmx = 32767
   set noexec_user_stack = 1 (Note: On Oracle 10g only)
   ``

   **Important** If you have been running the host computer as an Oracle database server, you have to check with your Solaris system administrator before changing these parameters. For these parameter settings, you can also refer to the Oracle documentation.

   **Note** Restart the computer if you modify the /etc/system file.

3. The previous kernel parameters are set in the distributed system.txt file. Append system.txt to /etc/system if this is the first time you are configuring the host computer as the database server.

   ```
   # cat /u01/oracle/agilepitmp/system.txt >> /etc/system
   ``

   **Note** Use `>>` to append. If you have accidentally used `>`, you need to recover the original /etc/system file by using `cp system_save system`.

4. Restart the system to make the new kernel configuration take effect.

   **Note** If you do not restart the system, the database creation will fail. You may need to check with your Solaris system administrator for support.

To set up Oracle environmental variables:

1. Log in to the system as the Oracle user.

2. Create the environmental parameter file .profile to include:

   ```
   PATH=$PATH:/usr/local/bin:/usr/ccs/bin:/usr/openwin/bin:/usr/bin/X11
   export PATH
   (Oracle 9i)ORACLE_HOME=/u01/app/oracle/product/9.2.0SE; export ORACLE_HOME
   (Oracle 10g)ORACLE_HOME=/u01/app/oracle/product/10.2.0/db_1; export ORACLE_HOME
   ORACLE_BASE=/u01/app/oracle; export ORACLE_BASE
   PATH=$PATH:$ORACLE_HOME/bin; export PATH
   ORACLE_SID=pidb; export ORACLE_SID
   TNS_ADMIN=/var/opt/oracle; export TNS_ADMIN
   NLS_LANG=American_America.UTF8; export NLS_LANG
   ``

3. The environmental parameters in the previous step are set in the distributed profile.txt file. If this is the first time you are configuring the host computer as a database server, copy the profile.txt file to .profile:

   ```
   $ cat agilepitmp/profile.txt > .profile [Enter]
   ``

4. Update the environmental setting:

   ```
   $ . ./profile [Enter]
   ```
Making the Oracle Installer Available

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the computer. Use the instructions in Appendix A, “Installing Oracle 9i” or Appendix B, “Installing Oracle 10g” to copy the data from the installation CDs.

Installing the Oracle Database

Use the instructions in Appendix A, “Installing Oracle 9i” or Appendix B, “Installing Oracle 10g” to install the Oracle database, if it is not already installed.

vxfs File System Support

On Solaris, Agile officially supports the native Solaris file system. To enable the vxfs file system for testing, remove the bold text as shown in the pidb.sh script:

```
space=`df -kFufs $dir | nawk '{getline;print $4/1024}''
```

After modification, the line should appear as follows:

```
space=`df -k $dir | nawk '{getline;print $4/1024}''
```

Creating the Product Interchange Database

This section describes how to create the default database instance and schema used by Product Interchange using the database creation utility.

To start the installation:

1. Log in to the computer as the Oracle user.
   a. If necessary, edit the .profile file to change Oracle SID. By default, Agile uses pidb as the Oracle SID:
      ```
      $ vi .profile [Enter]
      ```
   b. Modify the value where ORACLE_SID=pidb by replacing pidb with the SID you want to use.

   **Important** Check the /var/opt/oracle/oratab file and make sure that the specified Oracle SID has not been used. Specifying an existing Oracle SID can corrupt that database instance.

   **Note** Generally, the SID length is four alphanumeric characters. This avoids lengthy database filenames for associated database files.

   c. Run .profile to make the SID changes take effect:
      ```
      $. ./chmod u+x .profile [Enter]
      ```

2. In a second terminal session, log in to the computer as the root user.

3. Create a directory named “oradata.”
   **Note** The pidb.sh file uses a dummy mount point /mpt. You must change /mpt to match your mount points. For OFA compliance, it is highly recommended that you create at least four mount points (preferably on four different disks across multiple controllers) to optimize disk I/O.

   For example, if you have mount points at /u01 and /u02, you can create an oradata folder on each mount point.
   ```
   # mkdir -p /u01/oradata
   # chown oracle:dba /u01/oradata
   ```

4. In the session where you are logged in as the Oracle user, create a $ORACLE_BASE/admin directory:
   ```
   $ mkdir -p /u01/app/oracle/admin [Enter]
   ```
You must now run the pidb.sh script.

5 Change to the /u01/oracle/agilepitmp directory.

6 Modify the pidb.sh script to match the mount points on your computer, and then copy the script to the Oracle user home directory (/u01/oracle).

**Important** Make sure ORACLE_SID matches the one you set for .profile, which should have taken effect after you ran ./.profile.

**Note** The pidb.sh file uses a dummy mount point /mpt. You must change /mpt to match your mount points. For OFA compliance, it is highly recommended that you create at least four mount points (preferably on four different disks across multiple controllers) to optimize disk I/O.

The values in the script that can be modified appear in bold. You should limit your editing only to these bold values.

For example, if you have a mount point created at /u01, you can modify pidb.sh and quickly recreate it in the Oracle user home directory by issuing one command.

```
$ cat /u01/oracle/agilepitmp/pidb.sh | sed -e "s/mpt\//u01\//g" > /u01/oracle/pidb.sh
$ chmod u+x /u01/oracle/pidb.sh
```

Note: The following code list variable in bold that you may want to revise besides dummy mount point /mpt

```
#!/bin/sh
#
#ACLE PLM Database Installation Guide
#
#  ==============================================================
#  Copyright (c) 1995-2005 Agile Software Corporation
#  All Rights Reserved.
#  ==============================================================
#
# Oracle_sid default as pidb
#
ORACLE_SID=pidb    # Oracle SID for the database
AASYSPW=oracle     # Oracle sys passwd for the database
AASYSTEMPW=manager # Oracle system passwd for the database
PIUSER=piuser      # Oracle account for piuser schema
PIUSERPW=piuser    # Oracle passwd for piuser
DWE=dwe            # Oracle account for DWE schema
DWEPW=dwe          # Oracle passwd for DWE
#
# Parameters determine location of datafiles, controlfiles and logfiles
#
DATABASE_SYSTEM=/mpt/oradata/${ORACLE_SID} # SYSTEM tablespace
DATABASE_SYSaux=/mpt/oradata/${ORACLE_SID} # SYSAUX tablespace
DATABASE_TOOLS=/mpt/oradata/${ORACLE_SID} # TOOLS tablespace
DATABASE_UNDO=/mpt/oradata/${ORACLE_SID} # RBS tablespace
DATABASE_TEMP=/mpt/oradata/${ORACLE_SID} # TEMP tablespace
DATABASE_USERS=/mpt/oradata/${ORACLE_SID} # USERS tablespace
DATABASE_INDEX=/mpt/oradata/${ORACLE_SID} # INDX tablespace
DATABASE_AGILE_DATA1=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDEX1=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_DATA2=/mpt/oradata/${ORACLE_SID}
```


Chapter 6 Installing the Product Interchange Database on Solaris

DATABASE_AGILE_INDX2=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_DATA3=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDX3=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_DATA4=/mpt/oradata/${ORACLE_SID}
DATABASE_AGILE_INDX4=/mpt/oradata/${ORACLE_SID}
DATABASE_LOGFILES1=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 1
DATABASE_LOGFILES2=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 2
DATABASE_LOGFILES3=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 3
DATABASE_LOGFILES4=/mpt/oradata/${ORACLE_SID}  # REDOLOG file 4
DATABASE_CONTROL1=/mpt/oradata/${ORACLE_SID}   # CONTROL file 1
DATABASE_CONTROL2=/mpt/oradata/${ORACLE_SID}   # CONTROL file 2
DATABASE_CONTROL3=/mpt/oradata/${ORACLE_SID}   # CONTROL file 3
DATABASE_ARCHIVE=/mpt/oradata/${ORACLE_SID}/arch  #ARCHIVELOGS

# Parameters determine character set used
# CHARACTER_SET=UTF8
# NATIONAL_CHARACTER_SET=UTF8

7 Run the pidb.sh script from the Oracle user home directory:

$ cd
$ cp agilepitmp/agilepischema.dmp .
$ ./pidb.sh

Note If you are unable to create files, you may have to give the system user full privileges to the u01 directory.

8 You are prompted about the database size that you want to install.

You should use the regular database size unless you have consulted with an Agile Solutions Consultant or
database administrator to ensure that the computer meets the minimum requirements for the specified database
size.

The script will run for awhile.

Important Change all Oracle database user passwords after you have created the Product Interchange database. It is
recommended to change these passwords periodically for security purposes.

Continue to the next section for post-installation tasks.

Post-Installation Tasks

This section describes how to configure Oracle Net Manager, and set the automatic startup and shutdown features
for the database.

Setting Up Oracle Net Manager

To set up Oracle Net Manager:

1 Log in as root and change the ownership of the /var/opt/oracle directory:

   # chown -R oracle:dba /var/opt/oracle [Enter]

2 Switch to the Oracle user, and change to the Oracle network directory:

   # su - oracle [Enter]
   $ cd Oracle_Home [Enter]

3 Move all the files to the directory defined by environmental parameter TNS_ADMIN, which is /var/opt/oracle:

   $ mv * /var/opt/oracle [Enter]
Setting Up Automatic Shutdown and Startup for the Database

To set up the Oracle database to automatically shut down and start up when the host computer starts up and shuts down:

1. Log in the system as root.
2. Create a file named “dbora” in the /etc/init.d directory:
   
   ```bash
   # cat /u01/oracle/agilepitmp/dbora > /etc/init.d/dbora [Enter]
   ```
3. Link to the dbora file:
   
   ```bash
   # ln -s /etc/init.d/dbora /etc/rc0.d/K10dbora [Enter]
   # ln -s /etc/init.d/dbora /etc/rc2.d/S99dbora [Enter]
   ```
Configuring the listener.ora File

To configure the listener.ora file:

1. Start Net Manager:
   
   `$ netmgr &`

2. Within the Local folder, open the Listeners folder and select LISTENER.

   Check to see if the following settings appear in one of the Address tabs:
   
   - **Protocol**: TCP/IP
   - **Host**: the host computer where the Oracle database is installed
   - **Port**: 1521

   a. If the information does *not* appear, click Add Address.
      A new Address tab appears.

   b. Type these settings:
      
      - **Protocol**: TCP/IP
      - **Host**: the host computer where the Oracle database is installed
      - **Port**: 1521

   c. Select Database Service in the Listener Location drop-down list.

   d. Click Add Database.

      In the dialog box that appears, make the following changes:
      
      - **Global Database Name**: pidb
      - **Oracle Home Directory**: Oracle_Home
      - **SID**: pidb

3. Choose **File > Save Network Configuration** to save your changes.

Configuring the tnsnames.ora File (Optional)

1. In the Oracle Net Manager window, double-click the Local folder and select the Service Naming folder.
2. Click Create in the toolbar to add a service name.
   The Net Service Name Wizard starts.
3. In the Net Service Name field, type the name of the computer where the Oracle database is located (usually the current computer). Click Next.
4. You are prompted to select a network protocol. Select TCP/IP (Internet Protocol) and click Next.
5. Type the name of the computer where Oracle is located in the Hostname field (the same name you typed in step 3). Accept 1521 as the default port number. Click Next.
6. Select Oracle8i or later as the service name, and type pidb in the field. Click Next.
7. Click Test to test the service.
   The test initially fails because the default uses the incorrect login.
8. Click Change Login to reset the username and password.
9. Type piuser in the Username field and piuser in the Password field. Click OK.
10. Click Test.
    You should now see a message indicating that the test was successful.
11. Click Close.
12. Click Finish to exit the Net Service Name Wizard.
13. From the Net Manager menu, choose File > Save Network Configuration to save the service name.

This completes the installation and configuration for Oracle on Solaris.
CHAPTER 7

Upgrading the Product Interchange Database

This chapter explains how to upgrade the Product Interchange database. It includes this topic:

- Upgrading the Product Interchange Database

Upgrading the Product Interchange Database

If you have Product Interchange version 9.0 SP4, 9.0 SP5 Hotfix 1, or 9.2 installed, you can upgrade your database to Product Interchange version 9.2.1.

Before upgrading, you MUST install the Product Interchange application. After installing Product Interchange, the directory containing the upgrade scripts is created. To install Product Interchange, see the installation guide for your specific application server, *Installing Agile PLM with Oracle Application Server* or *Installing Agile PLM with BEA WebLogic*.

To upgrade the Product Interchange database from version 9.0 SP4 to version 9.2.1:

1. On the database server, backup the Product Interchange database by exporting the piuser schema.
2. Open a Command Prompt window on the machine where Product Interchange 9.2.1 is installed.
3. Change to the `<Agile_Home>\AgilePI\upgrade` directory.
4. Log in to SQL*Plus as the piuser:
   
   `sqlplus piuser/piuser@oracle-sid`

5. Run the `90sp4to921.sql` upgrade script.
6. Back up the upgraded database by exporting the piuser and dwe schemas.

To upgrade the Product Interchange database from version 9.0 SP5 Hotfix 1 to version 9.2.1:

1. Check to make sure the i2, Arrow, and Avnet data source profiles exist in the Product Interchange application. If they do not exist, you need to run additional upgrade scripts in steps described below.
2. On the database server, back up the database by exporting the piuser schema.
3. Open a Command Prompt window on the machine where Product Interchange 9.2.1 is installed.
4. Change to the `<Agile_Home>\AgilePI\upgrade` directory.
5. Log in to SQL*Plus as the piuser:
   
   `sqlplus piuser/piuser@oracle-sid`

6. Run the `90sp5HF1to921.sql` upgrade script.
If the i2 data source profile needs to be created, run the following script: i2DSProfile.sql.

If the Avnet data source profile needs to be created, run the following script: AvnetDSProfile.sql.

If the Arrow data source profile needs to be created, run the following script: ArrowDSProfile.sql.

Back up the upgraded database by exporting the piuser and dwe schemas.

To upgrade the Product Interchange database from version 9.2 to version 9.2.1:
1. On the database server, back up the database by exporting the piuser schema.
2. Open a Command Prompt window on the machine where Product Interchange 9.2.1 is installed.
3. Change to the `<Agile_Home>\AgilePI\upgrade` directory.
4. Edit the 92to921.sql file with the following steps:
   a. Replace the string @AlterTable.sql with @alterTable921.sql.
   b. Replace the following lines:
      ---===== Drop Columns from PmPartMatches =====---
      @dropColumns.sql;

      with
      ---===== ADD Columns to PMPartMatches =====---
      ALTER TABLE PM_PART_MATCHES ADD ( 
      ROHS VARCHAR2(15) NULL,
      LEADFREE VARCHAR2(15) NULL,
      LAST_ORDER VARCHAR2(55) NULL,
      LAST_SHIP VARCHAR2(55) NULL,
      TOTAL_WEIGHT VARCHAR2(55) NULL,
      PACKAGE_MATERIAL VARCHAR2(55) NULL,
      STATUS VARCHAR2(55) NULL,
      LIFECYCLE_STAGE VARCHAR2(55) NULL 
    ) ;
    ALTER TABLE PM_PART_MATCHES MODIFY PART_URL 
    VARCHAR2(550) ;

5. Edit the dropColumns.sql file by removing the following lines at the end of the file:
   ALTER TABLE PM_PART_MATCHES ADD ( 
   ROHS VARCHAR2(15) NULL,
   LEADFREE VARCHAR2(15) NULL,
   LAST_ORDER VARCHAR2(55) NULL,
   LAST_SHIP VARCHAR2(55) NULL,
   TOTAL_WEIGHT VARCHAR2(55) NULL,
   PACKAGE_MATERIAL VARCHAR2(55) NULL,
   STATUS VARCHAR2(55) NULL,
   LIFECYCLE_STAGE VARCHAR2(55) NULL 
  ) ;
  ALTER TABLE PM_PART_MATCHES MODIFY PART_URL 
  VARCHAR2(550) ;

6. Log in to SQL*Plus as the piuser:
   sqlplus piuser/piuser@oracle-sid

7. Run the 92to921.sql upgrade script.
8. Change to the `<Agile_Home>\AgilePI\pidataload\config` directory.
9. Edit the config.properties file with the Agile PLM database details, then save the file.
10. Change to the `<Agile_Home>\AgilePI\pidataload` directory.
11. Run the run92To921Upgrador file with the edited configuration file, as follows:
run92To921Upgrador \\pidataload\config\config.properties

12 If all of the previous steps have completed successfully, log in to SQL*Plus and run the dropColumns.sql script in the <Agile_Home>\AgilePI\upgrade directory.
APPENDIX A

Installing Oracle 9i

This appendix provides instructions for installing Oracle 9i (9.2.0.1.0) on Windows.

- Before Installing Oracle 9i on Windows
- Installing Oracle 9i Release 2 on Windows
- Making the Oracle Installer Available on Solaris
- Installing Oracle 9i Release 2 on Solaris

Before Installing Oracle 9i on Windows

Before installing Oracle, you must:

- Verify that Windows has been configured correctly. See “Checking the Windows File System” on page A-2 for directions.
- Check to see that the Microsoft NTFS file system is used instead of FAT or FAT32, and convert the file system if necessary. See “Checking the Windows File System” on page A-2 for directions.
- Determine the name of the Windows computer where Oracle is to be installed. The target installation folder for the Oracle database is recommended to be d:\oracle\ora92.
  
  Note It is required that the computer on which you are installing the Oracle database have at least two physical drives or two partitions. This allows you to place the operating system on the C drive and use the D drive for Oracle components. The examples in this chapter use a C and D drive.
- Be sure that you have Administrator privileges within Windows on the computers where you are installing Oracle and Agile PLM 9.2.1.
- Disable disk compression, if you are using it.
- Disable virus protection, if you are using it. Components used in the installer can be falsely identified as being infected and lock up the installation. You can turn the virus protection on after the installation is complete.

The following sections provide more information about these procedures.

Network Check

Before proceeding, it is important to confirm two settings to prevent difficulties from occurring.

Confirming Computer Name and Hostname Identities

The computer where Oracle is installed must use the same value as both its computer name and its DNS hostname. The following procedures can be used to identify the current values.
To determine the computer name for Windows:

1. Right-click the My Computer icon on the desktop, and choose Properties in the shortcut menu.
2. In the System Properties dialog box, click the Computer Name tab.
3. Note the name listed in the Full Computer Name field.

Note: Windows uses the same name for the computer name and DNS hostname.

Confirming the Server Date

It is important to adjust the date and time of the computer. The date and time need to be correct when you work with your production data.

To confirm the date and time, click the Date/Time icon in the Windows Control Panel. Be sure to verify the Time Zone setting, too.

Caution! If you change the date or time after Agile PLM 9.2.1 has been installed and started, you need to stop and restart the application server immediately after the change.

Checking the Windows File System

Agile recommends that servers use NTFS (NT File System) rather than FAT or FAT32 (File Allocation Table), as NTFS is more robust.

To determine the file system type:

1. Check the file system used on the computer. Choose Start > Administrative Tools > Computer Management. Under Computer Management in the left pane, expand Storage and select Disk Management.

   The Disk Administration windows opens.

   There must be at least two partitions or hard drives. If your computer uses NTFS, proceed with the Oracle installation. If your computer uses a FAT or FAT32 file system, Agile recommends converting it to NTFS before proceeding.

   Important: Converting the file system deletes all current files on the drive. Backup all necessary files before converting the file system to NTFS.

2. Right-click on the drive you want to reformat and choose Format in the shortcut menu.
3. In the File System field, change the file system type to NTFS.
4. Click Start.

   The process takes several minutes. On completion, restart the system. You can proceed with the Oracle installation.

Installing Oracle 9i Release 2 on Windows

These instructions describe how to install and configure Oracle 9i to run with Agile PLM 9.2.1.

Note: Throughout the instructions, default values are shown (such as the installation path or the service name). If you change any of these values during the installation, update the information specific to your installation where appropriate.

Important: Make sure the Distributed Transaction Coordinator service is stopped.

To install Oracle 9i:

1. Insert the Oracle database installation CD. You may have to navigate to the CD drive. Click Next.
2. The Oracle Universal Installer welcome screen appears. Click Next.

   The File Locations window appears.
Appendix A  Installing Oracle 9i

3 Make sure the Oracle home folder is on the D drive at d:\oracle\ora92. Click Next.
   Note If you are installing Oracle on a different drive, specify that drive instead.
   The Available Products window appears.
4 Select Oracle9i Database 9.2.0.1.0. Click Next.
   The Installation Types window appears.
   Note If you have more than 4 CPUs, you must use Oracle 9i R2 Enterprise Edition. The Standard Edition license only allows you to install on a server having up to 4 CPUs.
   The Database Configuration window appears.
6 Select Software Only. Click Next.
   The Oracle Services for Microsoft Transaction Server window appears.
7 Accept the default 2030 port number. Click Next.
8 Review the information to ensure that you have enough disk space. Click Install.
   The Install window appears and displays a progress meter.
9 Insert the remaining CDs when prompted and browse to the \stage folder to continue the installation.
10 Click Exit when the installation is complete.
   The Add Databases to tree dialog appears.
11 Click Cancel.
12 Choose File > Exit from the Oracle Enterprise Manager Console window.

Editing the sqlnet.ora File

For databases installed on Windows Server computers, you must check the sqlnet.ora file to make sure authentication services are configured correctly.

To edit the sqlnet.ora file:
1 Go to the d:\oracle\ora92\network\admin folder.
2 In a text editor, open the sqlnet.ora file and look for the following parameter:
   SQLNET.AUTHENTICATION_SERVICES
3 If the parameter is set to (None), you do not need to edit the file.
4 If the parameter is set to (NTS), place a pound symbol (#) at the beginning of the line so it appears as follows:
   # SQLNET.AUTHENTICATION_SERVICES= (NTS)
   Note If you do not want to comment out the line, you can change (NTS) to (NONE).
5 Save and close the file.

This completes the Oracle installation. You must now create the Agile database as described in “Using the Agile Database Configuration Utility” on page 2-3.

Making the Oracle Installer Available on Solaris

Note Oracle 9i Release 2 (9.2.0.1.0) uses three CDs. To avoid changing CDs during the installation, you should create an area containing the Oracle installation files.

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the Solaris computer.
To copy the Oracle installer onto the computer:

1. Log in as `root`, and create the stage folder:
   ```
   # mkdir /u01/oracle/stage [Enter]
   ```
2. Insert the first installation CD for Oracle on Solaris.
   Solaris automatically mounts the CD to the mounting point `/cdrom`.
3. Change to the `cdrom` folder:
   ```
   # cd cdrom [Enter]
   # ls [Enter]
   ```
4. Copy the first Oracle CD to the stage folder:
   ```
   # cup -r /cdrom/orcl9201_1 /u01/oracle/stage/. [Enter]
   ```
5. Eject the Oracle CD and insert the second Oracle CD.
6. Copy the second installation CD to the stage folder:
   ```
   # cup -r cdrom/orcl9201_2 /u01/oracle/stage/ [Enter]
   ```
7. Eject the second Oracle CD and insert the third Oracle CD.
8. Copy the third installation CD to the stage folder:
   ```
   # cp -r cdrom/orcl9201_3 /u01/oracle/stage/ [Enter]
   ```
Continue with installing Oracle 9i Release 2.

**Installing Oracle 9i Release 2 on Solaris**

This section describes how to install Oracle 9i Release 2 on Solaris. You install the Agile database after you install the Oracle software.

**To install Oracle:**

1. Log in to the computer as the Oracle user.
2. Change to the `/u01/oracle/stage/orcl9201_1` directory, and run the installer:
   ```
   $ cd /u01/oracle/stage/orcl9201_1 [Enter]
   $ ./runInstaller & [Enter]
   ```

   **Note** You may have to set the DISPLAY environmental variable to get the installer to start. If you have problem setting up the DISPLAY variable, check with your Solaris system administrator.

3. The Welcome screen appears. Click **Next**.
4. If this is the first time any Oracle products have been installed on this computer, you are prompted for the inventory location which is the base directory where all Oracle files will reside. Click **OK** to accept the default location.
5. If this is the first time any Oracle products have been installed on this computer, you are prompted for the Solaris group name. Type `oinstall` and click **Next**.
   a. A window appears prompting you to run the `orainstRoot.sh` script.
   b. Open another terminal session, and log in to the system as `root`.
   c. Run the `orainstRoot.sh` script.
      Leave the terminal session window open.
   d. After the script finishes, return to the Oracle installation window and click **Continue**.
6. Make sure the `ORACLE_HOME` directory is `/u01/app/oracle/product/9.2.0SE`. Click **Next**.
   The Available Products window appears.
7. Select **Oracle9i Database 9.2.0.1.0**. Click **Next**.
The Installation Types window appears.

8 Select Standard Edition. Click Next.

The Database Configuration window appears.

9 Select Software Only. Click Next.

A summary appears showing all selected settings.

10 Click Install.

A message appears saying that the installation is continuing.

11 After the installer completes the installation with the first disk, you are prompted for the location of the second disk. Type /u01/oracle/stage/orcl9201_2/ and click OK to continue.

12 After the installer completes the installation with the second disk, you are prompted for the location of the third disk. Type /u01/oracle/stage/orcl9201_3/ and click OK to continue.

When the installation finishes, the Setup Privileges window appears and prompts you to run the root.sh script as root.

13 In the second terminal session, log in the system as the root user. Change to $ORACLE_HOME:

```
# cd /u01/app/oracle/product/9.2.0SE
# ./root.sh
```

14 Press Enter to accept /usr/local/bin as the local bin directory.

15 Return to the Oracle installation window, and click OK.

The End of Installation dialog box appears.

16 Click Exit and then Yes when the verification dialog box appears.

The Add Databases to tree dialog appears.

17 Click Cancel.

18 Choose File > Exit from the Oracle Enterprise Manager Console window.

This completes the Oracle installation. You must now create the Agile database as described in “Creating the Agile Database” on page 3-5.
APPENDIX B

Installing Oracle 10g

This appendix provides instructions for installing Oracle 10g (10.2.0.1.0). It contains the following sections:

- Before Installing Oracle 10g on Windows
- Installing Oracle 10g Release 2 on Windows
- Making the Oracle Installer Available on Linux
- Making the Oracle Installer Available on Linux
- Installing Oracle 10g Release 2 on Solaris and Linux

Before Installing Oracle 10g on Windows

Before installing Oracle, you must:

- Verify that Windows has been configured correctly. See “Checking the Windows File System” on page B-2 for directions.
- Check to see that the Microsoft NTFS file system is used instead of FAT or FAT32, and convert the file system if necessary. See “Checking the Windows File System” on page B-2 for directions.
- Determine the name of the Windows computer where Oracle is to be installed.
  
  Note: It is required that the computer on which you are installing the Oracle database have at least two physical disks or two logical partitions. This allows you to place the operating system on the C drive and use the D drive for Oracle components. The examples in this chapter use a C and D drive.
- Be sure that you have Administrator privileges within Windows on the computers where you are installing Oracle and Agile PLM 9.2.1.
- Disable disk compression, if you are using it.
- Disable virus protection, if you are using it. Components used in the installer can be falsely identified as being infected and lock up the installation. You can turn the virus protection on after the installation is complete.

Network Check

Before proceeding, it is important to confirm two settings to prevent difficulties from occurring.

Confirming Computer Name and Hostname Identities

The computer where Oracle is installed must use the same value as both its computer name and its DNS hostname. The following procedures can be used to identify the current values.
To determine the computer name for Windows:
1. Right-click the My Computer icon on the desktop, and choose Properties in the shortcut menu.
2. In the System Properties dialog box, click the Computer Name tab.
3. Note the name listed in the Full Computer Name field.
   Note: Windows uses the same name for the computer name and DNS hostname.

Confirming the Server Date

It is important to adjust the date and time of the computer. The date and time need to be correct when you work with your production data.

To confirm the date and time, click the Date/Time icon in the Windows Control Panel. Be sure to verify the Time Zone setting, too.

Caution! If you change the date or time after Agile PLM 9.2.1 has been installed and started, you need to stop and restart the application server immediately after the change.

Checking the Windows File System

Agile recommends that servers use NTFS (NT File System) rather than FAT or FAT32 (File Allocation Table), as NTFS is more robust.

To determine the file system type:
1. Check the file system used on the computer. Choose Start > Administrative Tools > Computer Management. Under Computer Management in the left pane, expand Storage and select Disk Management.
   The Disk Administration windows opens.
   There must be at least two partitions or hard drives. If your computer uses NTFS, proceed with the Oracle installation. If your computer uses a FAT or FAT32 file system, Agile recommends converting it to NTFS before proceeding.
   Important: Converting the file system deletes all current files on the drive. Backup all necessary files before converting the file system to NTFS.
2. Right-click on the drive you want to reformat and choose Format in the shortcut menu.
3. In the File System field, change the file system type to NTFS.
4. Click Start.
   The process takes several minutes. On completion, restart the system. You can proceed with the Oracle installation.

For Servers Configured with DHCP

If your server is configured with DHCP (Dynamic Host Configuration Protocol), there is a known issue with the Oracle 10g installation. The installation fails and the following message displays:

Thrown When the IP address of a host can not be determined

There are two possible solutions:
1. Copy the Oracle 10g installation software to your local disk and perform an off-network installation OR
2. Install the Microsoft Loopback adapter on the DHCP server, then add one entry to the hosts file.

To install the Microsoft Loopback adapter:
1. Click Start > Control Panel > Add/Remove Hardware.
   The Add/Remove Hardware wizard appears.
Appendix B  Installing Oracle 10g

2  Click Next.

3  Choose Yes, I have already connected the hardware, then click Next.

4  Choose Add a new hardware device, then click Next.

5  Choose Install the hardware that I manually select from a list, then click Next.

6  Select Network adapters, then click Next.

7  In the Manufacturers list, select Microsoft.

8  In the Network Adapter list, select Microsoft Loopback Adapter, then click Next.

9  Click Next to install the adapter.

10  Click Finish.

To configure the hosts file:

1  Open the hosts file, located at C:\Windows\System32\drivers\etc.

2  Add the following entry to the hosts file:

   10.10.10.10 hostname.domain hostname

   For example, if the full machine name of your database server is db1.agile.agilesot.com, the entry in the hosts
   file would be:

   10.10.10.10 db1.agile.agilesoft.com db1

3  Save the file.

To configure the loopback IP address on the network:

1  On the database server, right-click the My Network Places icon.

2  Choose Properties to display the Network and Dial-up Connections window.

3  Locate a connection with the device name of Microsoft Loopback Adapter. This connection is usually Local Area
   Connection 2.

4  Right-click this connection icon.

5  Choose Properties to display the Local Area Connection 2 Properties dialog box.

6  On the General tab, select Internet Protocol (TCP/IP), then click Properties to display the Internet Protocol (TCP/IP)
   properties dialog box.

7  On the General tab, choose Use the following IP Address.

8  Enter the following values:

   IP address: 10.10.10.10

   Subnet mask: 255.255.255.0

9  Click OK.

10  Click Close.

On completion, restart the system. You can proceed with the Oracle installation.

Installing Oracle 10g Release 2 on Windows

These instructions describe how to install and configure Oracle 10g to run with Agile PLM 9.2.1. The Oracle 10g
installation for Agile PLM 9.2.1 requires the database software and the Oracle Text Knowledge component contained
on the Oracle 10g Release 2 Companion CD.
Throughout the instructions, default values are shown (such as the installation path or the service name). If you change any of these values during the installation, update the information specific to your installation where appropriate.

Make sure the Distributed Transaction Coordinator service is stopped.

To install Oracle 10g:

1. Insert the Oracle database installation CD. You may have to navigate to the CD drive.
2. Double-click the **Setup** icon.
3. Click **Next**.
4. Select **Basic Installation**. Make sure the Oracle Home Location is on the D drive at d:\oracle\product\10.2.0\db_1 which is the default if you have two disks.
5. Select **Standard Edition** as the Installation Type. Click **Next**.
   - Do not check Create Starter Database. You will create the Agile database with the Database Configuration Utility.
6. The Oracle Universal Installer verifies that your server meets the minimum requirements for installing and configuring the options you have selected. If your system passes, a summary window appears. Click **Next**.
7. Click **Install**.
8. Click **Exit** when the installation is complete.

After you install the database software, you must use the Oracle 10g Release 2 Companion CD to install Oracle Text, a product required by the full text search functionality of Agile PLM 9.2.1.

To install the Oracle 10g Companion products:

1. Insert the Oracle 10g Companion CD. You may have to navigate to the CD drive.
2. Double-click the **Setup** icon.
3. Click **Next**.
4. Click **Oracle Database 10g Products 10.2.0.1.0**. Click **Next**.
5. Select the Oracle Home where you installed the Oracle 10g database. Click **Next**.
6. The Oracle Universal Installer verifies that your server meets the minimum requirements for installing and configuring the options you have selected. If your system passes, a summary window appears. Click **Next**.
7. Click **Install**.
8. Click **Exit** when the installation is complete.

This completes the Oracle installation. You must now create the Agile database as described in “Using the Agile Database Configuration Utility” on page 2-3.
Making the Oracle Installer Available on Solaris

Note Oracle 10 Release 2 (10.2) includes the database and companion CDs.

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the Solaris computer.

To copy the Oracle software onto the computer:

1. Log in as oracle, and create the software folder:
   ```
   # mkdir /u01/oracle/software
   [Enter]
   ```
   Note This step assumes you have created the user oracle with the home directory /u01/oracle.

2. Copy or FTP the following two files in binary mode from the CDs to the software directory:
   ```
   10gr2_db_sol.cpio.gz
   10gr2_companion_sol.cpio.gz
   ```

3. Change to the software directory and unzip the files as follows:
   ```
   $ gunzip 10gr2_db_sol.cpio.gz [Enter]
   $ gunzip 10gr2_companion_sol.cpio.gz [Enter]
   ```

4. Create the CD directories:
   ```
   $ mkdir database [Enter]
   $ mkdir companion [Enter]
   ```

5. Copy the database CD contents to the database directory:
   ```
   $ cd /u01/oracle/software/database
   $ cpio -idmv</u01/oracle/software/10gr2_db_sol.cpio [Enter]
   ```

6. Copy the companion CD contents to the companion directory:
   ```
   $ cd /u01/oracle/software/companion
   $ cpio -idmv</u01/oracle/software/10gr2_companion_sol.cpio [Enter]
   ```

Continue with installing Oracle 10g Release 2.

Making the Oracle Installer Available on Linux

Note Oracle 10 Release 2 (10.2) includes the database and companion CDs.

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the Linux computer.

To copy the Oracle software onto the computer:

1. Log in as oracle, and create the software folder:
   ```
   # mkdir /u01/oracle/software
   [Enter]
   ```
   Note This step assumes you have created the user oracle with the home directory /u01/oracle.

2. Copy or FTP the following two files in binary mode from the CDs to the software directory:
   ```
   10201_database_linux32.zip
   10201_companion_linux32.zip
   ```

3. Change to the software directory and unzip the files as follows:
   ```
   $ unzip 10201_database_linux32.zip [Enter]
   $ unzip 10201_companion_linux32.zip [Enter]
   ```

Continue with installing Oracle 10g Release 2.
Installing Oracle 10g Release 2 on Solaris and Linux

This section describes how to install Oracle 10g Release 2 on Solaris and Linux. You can install the Agile database after you install the Oracle software.

To install Oracle:

1. Log in to the computer as the Oracle user.

2. Change to the /u01/oracle/software/database directory, and run the installer:

   ```
   $ cd /u01/oracle/software/database [Enter]
   $ ./runInstaller & [Enter]
   
   Note: You may have to set the DISPLAY environmental variable to get the installer to start. If you have trouble setting up the DISPLAY variable, check with your Solaris system administrator.
   ```

3. The Welcome screen appears. Click Next.

4. The Installation Method window appears.

5. Select Basic Installation.


   Note: Do not check Create Starter Database.

7. If this is a new Oracle installation, the Specify Inventory Directory and Credentials window appears. Accept the defaults and click Next.

    The Product Specific Prerequisite Checks window appears.

8. The Oracle Universal Installer verifies that your server meets the minimum requirements for installing and configuring the options you have selected. If your system passes, a summary window appears.

9. Click Install.

10. Click Exit when the installation is complete.

    Now, you can install the companion CD.

11. Change to the /u01/oracle/software/companion directory, and run the installer:

    ```
    $ cd /u01/oracle/software/companion [Enter]
    $ ./runInstaller & [Enter]
    
    The Oracle Universal Installer command window and welcome screen appear.
    ```

12. Click Next.

    The Select a Product to Install window appears.

13. Click Oracle Database 10g Products 10.2.0.1.0. Click Next.

    The Specify Home Details window appears.

14. Select the Oracle Home where you installed the Oracle 10g database. Click Next.

    The Product Specific Prerequisite Checks window appears.

15. The Oracle Universal Installer verifies that your server meets the minimum requirements for installing and configuring the options you have selected. If your system passes, a summary window appears.

16. Click Install.

17. Click Exit when the installation is complete.

This completes the Oracle installation. You must now create the Agile database as described in “Creating the Agile Database” on page 3-5.
It is important to protect your Agile data and system files from loss. This chapter describes basic backup and recovery strategies and gives specific information about applying them to your Agile system used with Oracle products.

The instructions in this appendix are for system and database administrators who need to manage the Agile database. The following topics are discussed:

- Database Maintenance
- Backing Up the Database
- Importing the Database
- Exporting the Database
- Creating a Schema in Oracle
- Deleting an Instance and the Database Files
- Database Recovery
- Running Scripts

Database Maintenance

This section provides database maintenance procedures.

Fine-Tuning Index Settings

Depending on your database server and the fields most frequently searched at your site, you may speed up searches by using an SQL script to create additional database indexes. If you are experiencing noticeably slow performance when searching on certain fields, contact Agile Technical Support to see if index modifications might help. Note that an added index needs to be analyzed for statistics, otherwise, the cost-based optimizer may not use it.

Monthly Maintenance

Plan for a regular monthly cold backup of your database as a maintenance measure.

Note An export of the Agile database may not be sufficient because a file content index synchronization is needed after data is imported to the database server.

Checking Database Space Allocation

Checking the tablespace data files in your Oracle database on a monthly basis can help determine how close your database storage is to maximum capacity. If any or all of the tablespaces are at least 90 percent, you should do the following:
Frequently export the agile schema to view the dump file size. You may need to consider migrating to a larger database sizing model.

Increase the disk space allocation for the specific tablespaces. One method for accomplishing this is to increase the data file size for the corresponding tablespaces, as follows:

a. Check the disk space for the hard drive where the Oracle database is located.
   If there is less than 500 MB available, it is recommended that you increase disk space by adding to or replacing the hard drive.

b. To check the tablespace data files, start the Enterprise Manager Console.
   The Oracle Enterprise Manager Login dialog box appears.

c. Select Launch standalone and click OK.

d. Double-click the Databases folder and the name of the database.

e. Log in as follows, and then click OK:

   Username: system
   Password: manager
   Service: hostname (remote) or blank (local)
   Connect As: normal

   **Note** Type the fully qualified hostname of the computer in the Service field (or Host String in some cases) if you are not logging in on the same computer where you have installed Oracle or if you receive a TNS error message.

f. Under Storage > Tablespaces, select System, Temporary, Agile_DATA1-4, and Agile_INDX1-4 and determine if the amount of disk space each tablespace is using exceeds 90 percent. Make sure Agile_INDX4 has enough space for file content index synchronization.

   **Note** If you need to increase the amount of available disk space, double-click the value in the Size field.

The Edit Datafile dialog box appears.

g. Increase the amount of available disk space, and then click OK.

   If possible, you should double the current disk space. If the disk space is not available on the hard drive, you should consider upgrading your hardware.

   **Note** This is a preventive and proactive measure, but is not required. All Agile tablespaces automatically extend by 10MB whenever additional disk space is needed and available.

**Dynamic Versus Static IP Addresses**

You can use dynamic IP addresses with “long-term lease” assignments, as well as static addresses, for Oracle systems. For best results, do not change the hostname of computers in the system, and use static IP addresses.

**Backing Up the Database**

You should institute routine backups of all servers. Agile recommends backing up entire disks to save both database and registry data.

Database losses are unfortunate, but they can and do occur. They can result from hardware failures, natural disasters, fire, power surges, and problems with administration and configuration. Whatever their cause, your best protection against business disruption and permanent data loss is an effective backup and recovery plan, applied as automatically as possible.
This chapter introduces several ways to back up and recover data. You will need additional information to adequately administer and protect your database. You may need to do a cost/benefit analysis to determine how often to back up critical data and to justify the labor, hardware, software, and storage costs involved. The following documents may be helpful:

- Oracle9i User-Managed Backup and Recovery Guide or Oracle Database Backup and Recovery Basics 10g Release 2
- Oracle9i Recovery Manager User’s Guide
- Oracle9i Database Concepts or Oracle Database Concepts 10g Release 2
- Legato Storage Manager Administrator’s Guide

Note The documents are available at Oracle’s Web site:

http://otn.oracle.com/documentation/oracle9i.html
http://www.oracle.com/technology/documentation/database10gR2.html

You must be a member of the Oracle Technology Network to have access to the site (becoming a member requires simply that you register at the site to gain access).

**Backup and Recovery Strategy**

When you are planning a backup and recovery strategy, you need to consider the following factors:

- **Database availability**
  
  What is the database availability requirement for business operations? Is it required for 7X24X365 availability or only during standard business hours?
  
  According to the availability requirement, different database backup methods can be adopted. If the database cannot be shut down, a hot online backup is the only choice.

- **ARCHIVELOG and NOARCHIVELOG mode**
  
  A database can run in ARCHIVELOG or NOARCHIVELOG mode.

  When the database is in operation, all database changes are recorded in redo log files. If the database is running in ARCHIVELOG mode, these redo log files are archived in the database archive log destination and are referred to as archived redo log files. A database running in ARCHIVELOG mode provides better protection from data loss. It can be recovered up to the point of failure. To perform a hot backup, a database must be running in ARCHIVELOG mode.

  The default configuration for the Agile database is NOARCHIVELOG mode. You can change the database to ARCHIVELOG mode following the instructions available in the initagile9.ora file. It is recommended that an Oracle DBA or Oracle support be available.

- **Data loss tolerance**
  
  How much data can you afford to lose due to a database crash?

  Can you afford to lose one day or one week’s worth of data in the event of a database crash? Can you re-enter user data if there is a database failure?

  If your database cannot tolerate data loss due to failure, then a good data protection backup method needs to be adopted, such as hot or cold backup using ARCHIVELOG mode.

- **Recovery time**
  
  How much time can you afford to spend recovering a database in the event of a crash?

  Different backup methods have different recovery times. Physical methods for backup and recovery are much faster than logical backups, and backups to disk are much faster than to tape. Recovery is also much faster from disk than from tape.

- **Technical skills**
What are the technical skills of your database or systems administrator?
Some backup methods require more database knowledge than others. Standby databases require more technical skill than cold or hot backup.

- Hardware or software investment
  - How much hardware or software investment do you want to put into to the system?
  - Some advanced features, such as high availability, require more of an investment in hardware and software.

You can determine the safest backup method for your environment based on database requirements, database running mode, and your recovery scenario (as described in the following table). However, the final decisions about the backup and recovery strategy you use is beyond the scope of this chapter. For detailed information to help you make these decisions, see the books listed on the previous page.

Table C-1: Scenarios for backup decisions

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Backup methods</th>
</tr>
</thead>
</table>
| The database requires 7X24 uptime and cannot be shut down | Hot backup  
Export  
Database must be running in ARCHIVELOG mode |
| The database is available during regular business hours and can be shutdown | Hot backup  
Cold backup  
Export  
Database can running in NOARCHIVELOG or ARCHIVELOG mode |
| To recover up to the point of failure          | Hot backup  
Cold backup with ARCHIVELOG mode |
| To recover an individual user or table          | Export |
| For fast recovery                               | Hot backup  
Cold backup |

**Implementing Backup Procedures**

For best backup results, follow these guidelines:
- Schedule online backups when there is minimal database access.
- Have a fixed schedule for online backups so users can plan for database slowdowns.
- Test your backup strategy to see if it is effective; make changes if any area is weak.
- Plan to save at least one version back; choose to retain enough versions for your business needs.
- Perform database consistency checks just before export or after import.
- Back up the master database before and after it is altered; if you save the original database creation scripts, you can use the same scripts to recreate it.
- For a distributed system, plan on coordinating backup procedures so each site can be backed up individually without destroying the integrity of the data at other sites.
- Oracle recommends that you export and re-import the database on a monthly basis to maintain optimum performance.
Useful Information for Backup and Maintenance Tools

If you use Oracle tools such as SQL Plus or third-party backup tools, you need to enter information about the Oracle database installation. Table C-2 lists default data; these names might differ if custom names were used instead of the defaults.

Table C-2: Oracle default field data

<table>
<thead>
<tr>
<th>Oracle Field</th>
<th>Default Data</th>
<th>Custom Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Sys account password</td>
<td>oracle</td>
<td></td>
</tr>
<tr>
<td>Oracle System account password</td>
<td>manager</td>
<td></td>
</tr>
<tr>
<td>Oracle Ctxsys account password</td>
<td>ctxsys</td>
<td></td>
</tr>
<tr>
<td>Oracle database Agile account username</td>
<td>agile</td>
<td></td>
</tr>
<tr>
<td>Oracle database Agile account password</td>
<td>tartan</td>
<td></td>
</tr>
<tr>
<td>Oracle database host name</td>
<td>Agile server hostname</td>
<td></td>
</tr>
<tr>
<td>Oracle database instance</td>
<td>agile9</td>
<td></td>
</tr>
</tbody>
</table>

Types of Backups

This section describe the following types of backups:

- Registry file backups
- System backups
- Standby database backups
- Standard database backups

System administrators often perform the first two types of backups, and database administrators (DBAs) perform the last two types of backups.

The last three types of backups should include backing up the Agile server files located at \Agile_dir\Agile9. These are the files needed to run Agile and the attachments to the Agile database. They should also include backing up the Oracle files located in the \oracle\oradata\instance_name folder.

Third-party backup procedures, such as Cheyenne Software’s ArcServe, are not described in this chapter. However, if you are using one, see “Useful Information for Backup and Maintenance Tools” on page C-5 for the default username and other Oracle database information.

Performing System Backups

You typically perform a system backup on a small system. You bring down the entire system, including all the programs, data files, and log files. Typically, a system backup is run each night.

To perform a system backup, shut down the system, start it up again in single-user or maintenance mode, then copy system files to tape, as follows:

1. Shut down active applications.
2. Shut down the relational database.
3. Stop the Agile Application Server process.
4. Bring the system back in single-user (maintenance) mode.
5. Back up all disks to tape with a suitable utility.
6. Start the Agile Application Server process.
7. Start the system in multi-user mode.
8 Rotate the database.
9 Restart applications as needed.

**Using Standby Databases**

Typically, a standby database is run on a large system. The standby database feature maintains a duplicate database of your primary online database at the same location or at a remote site. (Both the standby database and the primary database must be running on the same hardware platform, operating system, and Oracle patch release.) A standby database acts as a backup when it resides locally, and is implemented as part of a database disaster recovery strategy when it resides at a remote site. The standby database has the following features:

- It is copied from the primary or current production database onto a system residing locally or remotely.
- It is mounted, but not open, and is in constant recovery mode.
- Redo log files generated from the primary database can be transported to the standby database, and the standby database can apply these logs to recover the database.
- In the event of a disaster, a standby database can be activated and fully functional as a new production database.

A standby database takes time to set up and configure. For more information, see the references suggested in “Exporting the Database” on page C-9.

**Performing Database Backups**

Typically, you run a standard database backup daily. Databases backups can be:

- Cold or offline, where the database is shut down before copying database-related files: control files, data files, redo log files, initial parameter file (initagile9.ora), spfileagile9.ora, and password file (pwdagile9.ora). A database running in ARCHIVELOG or NOARCHIVELOG mode can be backed up by a cold backup (NOARCHIVELOG mode permits only cold backups).
- Hot or online, where a backup is performed while the database is open and users are accessing it. To perform a hot backup, a database must be running in ARCHIVELOG mode. When performing a hot backup, the database tablespace must first be put in backup mode, then the datafile can be copied by the operating system. Once the datafile has been copied, the database tablespace can be placed online again. This allows the database to be backed up tablespace by tablespace.
- A logical backup creates logical copies of database objects in a binary export file. Logical backups use the agile9 database utilities, agile9exp and agile9imp. When performing logical backups, a database must be open and running.

**Note** Oracle EXP and IMP utilities do not export the ctxsys account. So, FTS objects will be recreated during an agile9 import.

For best results, you should timestamp backups and generate scripts to perform them automatically using the operating system task schedule command.

**Performing Cold Backups**

Cold backups should be done on all the database-related files, including data files, control files, redo log files, the initial parameter file (initagile9.ora), the password file (pwdagile9.ora), and the server parameter file (spfileagile9.ora).

**To perform a cold backup on all database-related files:**

1. Shut down the database.
2. Use the operating system copy command to copy all of the database data files, the control file, the initial parameter file, the password file, and the archived redo log file (if the database is running in ARCHIVELOG mode) to the backup destination.
3 Restart the database.

For details, see the references suggested in “Exporting the Database” on page C-9.

**Performing Hot Backups**

Hot backups require a setup procedure, after which a backup is created every day. For instructions, see the references suggested in “Exporting the Database” on page C-9.

**Importing the Database**

“Exporting the Database” on page C-9 describes how to create a full backup of your Oracle database or a backup only of the Agile schema.

*Note* If you are prompted for the service name or host string, you must provide the fully qualified computer name.

To import the Agile schema on Windows:

1 Confirm that the schema is valid.
2 In a text editor, open the drive:\agile9tmp\dbvar.txt file and look for the following line:
   %AGILE%=agile
3 Change agile to the schema name you want to import, if applicable.
4 Save and close the file.
   *Note* The following commands use the D drive. If you have installed agile9tmp or Oracle on another drive, specify that drive letter.
5 Open another Command Prompt window, and type the following:
   d:
   cd agile9tmp
   agile9db.exe
6 In a Command Prompt window, type the following:
   cd oracle\admin\agile9\create
   recreateagile.bat
7 Before importing the database, you can check import parameters in the agile9imp.par text file, which contains the following parameters:
   
   file=agile9exp.dmp log=agile9imp.log fromuser=agile touser=agile indexes=n rows=y ignore=y grants=n constraints=n statistics=n
   
   where:
   
   file is the file to import. The DMP file schema version must match the latest schema version of agile9.exe.
   log is the import log file.
   fromuser is the user account in the file that contains the data that will be imported. fromuser must exist in the DMP file specified by the file.
   touser is the user account where the data is being imported. touser must match the current value of %AGILE%; otherwise, importing the data may cause data corruption.
   
   *Note* The indexes, rows, ignore, grants, constraints, and statistics parameters specify other import settings. Do not modify these parameters, and these settings should only be used when using the agile9imp script. If a standalone imp is used, do not use these settings.
8 To import the database and recreate indexes and statistics, type the following:
   agile9imp.bat
9 After the batch file finishes running, type **Exit** to close the Command Prompt window.
To import the Agile schema on Solaris and Linux:

1. Log in as the Oracle user.
2. Confirm that the database schema is valid.
3. Confirm that the user account name is new.
4. Make a backup of the existing database schema.
5. Change to the oracle user directory:
   
   ```
   $ cd
   ```
6. Copy agile9db from the agile9tmp directory:
   
   ```
   $ cp ./agile9tmp/agile9db.sh
   ```
7. Edit the agile9db shell script, and find AGILE=agile.
8. Change agile to the new, unused account name.
9. Save and close the file.
10. Run agile9db:
    
    ```
    $ chmod u+x agile9db.sh
    $ ./agile9db.sh
    ```

   You are prompted to choose a database size. Enter R for regular or L for large based on how you created the database initially.

   The script creates several SQL scripts and Bourne shell scripts in the following directory:
   
   `$ORACLE_BASE/admin/$ORACLE_SID/create`.

11. When the script finishes running, type the following:

    ```
    $ cd $ORACLE_BASE/admin/$ORACLE_SID/create
    ```

12. Run recreateagile:

    ```
    $ chmod u+x recreateagile.sh
    $ ./recreateagile.sh
    ```

13. Before importing the database, you can check import parameters in the agile9imp.par text file, which contains the following parameters:

    ```
    file=agile9exp.dmp log=agile9imp.log fromuser=agile touser=agile indexes=n rows=y ignore=y grants=n contraints=n statistics=n
    ```

    where:
    
    - `file` — File to import. The DMP file schema version must match the latest schema version of agile9.sh.
    - `log` — Import log file.
    - `fromuser` — User account in file that contains data to import. `fromuser` must exist in the DMP file specified.
    - `touser` — User account where the data is being imported. `touser` must match the current value of $AGILE. Otherwise, importing may cause data corruption.

   **Note** The `indexes`, `rows`, `ignore`, `grants`, `constraints`, and `statistics` parameters specify other import settings. Do not modify these parameters, and these settings should only be used when using the `agile9imp` script. If a standalone `imp` is used, do not use these settings.

14. To import the schema and recreate indexes and statistics, type the following commands:

    ```
    $ chmod u+x agile9imp.sh
    $ ./agile9imp.sh
    ```

   **Note** For file content index synchronization, call Agile Technical Support.

   **Note** For file content index synchronization, call Agile Technical Support.
Exporting the Database

For maximum data security, you should use a cold backup. You can import the Agile schema DMP file whenever you need to restore a database or replicate it on another computer with the exception of file content index synchronization because of its dependence on the file system.

If you are copying or moving the Agile schema to another computer, you need to set up the computer before importing the Agile schema.

Exporting the Full Oracle Database

When you perform a full export, you export all schemas in the Oracle database.

**Note** If you are prompted for the service name or host string, you must provide the fully qualified computer name.

To export the full Oracle database on Windows:

1. Ensure that all system users are logged off. The easiest way to do this is to disconnect the server from the network.
2. Open a Command Prompt window.
3. Set the character set:
   ```bash
   set NLS_LANG=American_America.utf8
   ```
4. Type the following text with spaces and a triple set of quotes as indicated (do not press Enter until you have typed the whole text string):
   ```bash
   exp system/manager full=y file=""""drive:\agile9tmp\exp_filename.dmp"""" log=""""drive:\agile9tmp\exp_filename.log"""
   ```
   **Note** Agile recommends naming the export file expfull.dmp. Replace *italics* in the above syntax with the actual information, for example:
   ```bash
   exp system/manager full=y file=""""d:\agile9tmp\expfull.dmp"""
   log=""""d:\agile9tmp\expfull.log"
   ```

To export the full Oracle database on Solaris and Linux:

1. Ensure that all system users are logged off. The easiest way to do this is to disconnect the server from the network.
2. Enter the following command:
   ```bash
   $ exp system/manager full=y file/u01/oracle/agile9tmp/ exp_filename.dmp log=/u01/oracle/agile9tmp/ exp_filename.log
   ```
   **Note** Agile recommends naming the export file expfull.dmp. Replace *italics* in the above syntax with the actual information, for example:
   ```bash
   exp system/manager full=y file=/u01/oracle/agile9tmp/expfull.dmp log=/u01/oracle/agile9tmp/expfull.log
   ```

The database export takes awhile. When it completes, open the log file and see if the export was successful. If there were problems, call Agile Technical Support.

You can copy the successful export of expfull.dmp to another secure computer as a backup.

Exporting the Agile Schema from Oracle

You can export only the Agile schema. This is much faster than exporting the full database.

**Note** If you are prompted for the service name or host string, you must provide the fully qualified computer name.
To export only the Agile schema (only Agile data) on Windows:

1 Ensure that all users are logged off before shutting down the application server.

   **Note** The following commands use the D drive. If you have installed agile9tmp or Oracle on another drive, specify that drive letter.

2 Open a Command Prompt window, and type the following:

```bash
d:  
cd \oracle\admin\agile9\create
```

3 Before exporting the database, you should check export parameters in the agile9exp.par text file, which contains the following parameters:

```bash
file=agile9exp.dmp log=agile9exp.log owner=agile
```

   where:

   - **file** is the file to export.
   - **log** is the export log file.
   - **owner** is the user account that contains data to export.

4 To export the database, type the following:

```bash
agile9exp.bat
```

To export only the Agile schema (only Agile data) on Solaris and Linux:

1 Ensure that all users are logged off. The easiest way to do this is to disconnect the server from the network.

2 Change to the directory where the Agile scripts are located:

```bash
$ cd $ORACLE_BASE/admin/$ORACLE_SID/create
```

3 Before exporting the database, you can check parameters for exporting in a text file named agile9exp.par, which contains the following parameters:

```bash
file=agile9exp.dmp log=agile9exp.log owner=agile
```

   where:

   - **file** — File to export.
   - **log** — Export log file.
   - **owner** — User account that contains data to export.

4 To export the database, type the following command:

```bash
$ chmod u+x agile9exp.sh  
$ ./agile9exp.sh
```

The database export takes awhile. When it is complete, open the log file and see if the export was successful. If there were problems, call Agile Technical Support.

You can copy the successful export of expdat.dmp to another secure computer as a backup.

**Creating a Schema in Oracle**

The Oracle database stores data in virtual containers known as schemas. The Agile Database Configuration Utility creates the database, user account, and schema used by Agile. Additional schemas are not necessary; however, you can create additional Agile schemas with different user names if necessary.

You should not use the Oracle Security Manager to create users.

**To create an additional agile schema with a different user account on Windows:**

1 Confirm that the user account name is new.

2 In a text editor, open the dbvar.txt file and look for the following line:
%AGILE% = agile

3 Change agile to the new, unused account name.

4 Save and close the file.

5 Open a Command Prompt window, and type the following:

   d:
   cd agile9tmp
   agile9db.exe

6 When the file finishes running, type the following:

   cd ..
   cd oracle\admin\agile9\create
   recreateagile.bat

To create an additional agile schema with a different user account on Solaris and Linux:

1 Confirm that the user account name is new.

2 Make a backup of the existing database schema.

3 Change to the oracle user directory:

   $ cd

4 Copy agile9db from the agile9tmp directory:

   $ cp ./agile9tmp/agile9db.sh

5 Edit the agile9db shell script, and find AGILE = agile.

6 Change agile to the new, unused account name.

7 Save and close the file.

8 Run agile9db:

   $ chmod u+x agile9db.sh
   $ ./agile9db.sh

   You are prompted to choose a database size. Enter R for regular or L for large based on how you created the database initially.
   
   The script creates several SQL scripts and Bourne shell scripts in the following directory:

   $ORACLE_BASE/admin/$ORACLE_SID/create.

9 When the script finishes running, type the following:

   $ cd $ORACLE_BASE/admin/$ORACLE_SID/create

10 Run recreateagile:

   $ chmod u+x recreateagile.sh
   $ ./recreateagile.sh

**Deleting an Instance and the Database Files**

Before creating a new instance, you should delete the existing instance (such as agile9).

1 Make sure the Oracle Listener (OracleOraHome92TNSListener) and Agile9 service (OracleServiceagile9) services are running.

2 Start the **Database Configuration Assistant**.

3 Select **Delete a Database**, and click **Next**.
   
   The instance you want to delete (Agile9) should appear in the **Available Instances** field.

4 Select the instance.

5 Type the username (sys) and password (oracle), if necessary.

6 Click **Finish**.
7 You are prompted to confirm the deletion, and then a message appears confirming that the instance has been removed.

8 Confirm that the agile9-related password file, spfile, and init files in the $ORACLE_HOME/dbs folder on Solaris have been deleted.

9 Confirm that the agile9-related password file, spfile, and init files in the %ORACLE_HOME\database folder on Windows have been deleted.

Note After dropping a database instance using the Database Configuration Assistant, the TEMP tablespace must be removed manually.

Database Recovery

In the case of failure, database recovery uses a previous database backup to recreate a database that is as complete, accurate, and up-to-date as possible. Database recovery depends on the database backup method. Two backup methods are standard backup and logical backup.

- For standard backup, including cold and hot backup, database recovery requires the use of the operating system copy command to restore backed up datafiles.
  - If the database is running in NOARCHIVELOG mode, there are no backed up archive log files. Recovery is to restore a previously backed up data file, control file, initial parameter file, and password file. No redo log files are applied and no database roll forward is needed. In this scenario, a database can be recovered up to the last backup.
  - If the database is running ARCHIVELOG mode, database recovery is to restore previous backed up database files up to the last archived log files. When recovering a database, these archived log files are applied and the database roll forward. In this scenario, a database can be recovered up to the point of database failure.

- For a logical backup, a database recovery involves importing the database or schema from a previous export DMP file. For a logical backup, there is no roll forward involved.

Database recovery can be performed by using Oracle Recovery Manager. For more database recovery information, see the references suggested in “Exporting the Database” on page C-9.

Using Oracle Recovery Manager

You can use the Oracle Recovery Manager to perform an automatic recovery, restore the full database, restore a data file, or restore a control file.

The major advantage for Oracle Recovery Manager (RMAN) is that it can perform incremental database backup and recovery. Incremental backup and recovery is much faster than a full database backup and recovery, especially for large database systems. RMAN is more complicated to setup compared with a standard backup.

Running Scripts

Important Before running a script, make sure you have a current backup (export) of your Agile database. For instructions on exporting (creating a DMP backup of your Agile database), refer to your Oracle documentation or Help system.

To run an SQL script against an Oracle database on Windows:

1 Copy the SQL script to the Agile9tmp folder on your Oracle server. For example, copy to drive:\Agile9tmp.
2 On the computer where Oracle is installed, start SQL Plus in a command prompt window.
3 Type the login and password (the defaults are agile and tartan).
4 Before running the script, create a spool file to record and contain the results from issuing the SQL script. At the SQL prompt type:
sparrow d:\Agile9tmp\filename.lst

For example: spool d:\Agile9tmp\averifyresults.lst

Note  The file with the LST extension is any filename that you want to use to identify the file that will contain these results. It is best and easiest to give the LST file the same name as the filename that is attached to the SQL file.

For example, if the SQL file to be run is oracle_averify90.sql, then name the spool file oracle_averify90.lst. You can also specify a drive or location other than what is shown in the previous example.

The drive and location specified are where the spool file will be saved.

5  Issue the command to run the SQL script by typing the following at the SQL prompt:

@d:\Agile9tmp\filename.sql

For example: @d:\agile9tmp\oracle_averify90.sql

Note  The @ symbol must be typed directly in front of this command line.

The file with the SQL extension is the name of the specific SQL file to be issued against the database. Depending on where the SQL file is located on the server, you will also specify the drive and location, which could be something other than the d:\agile9tmp shown in the example.

Notice the process of the script being executed. When it is complete, there will be an indication of “commit, complete.”

6  At the SQL prompt, type the following: spool off

7  Close the SQL Plus window and exit SQL Plus.

   Note  In some cases where a change is being made to the database, you may need to stop and restart both Agile services for the change to take effect. If this is necessary, you will be advised at the time the script is provided. In the case of issuing scripts that do not make changes to the database scripts (for example, oracle_averify.sql scripts), restarting the Agile services is not necessary.

8  Locate and open the spool file created in step 4, if necessary.

The file can be opened within an application such as Notepad so that results can be viewed and printed, if necessary.
INDEX

A
Agile 9.2.1
  scripts C-12
  server date and time A-2, B-2
  software requirements 1-2
  system requirements 1-1
Agile database
  configuration utility 2-3, 3-5, 4-4, 5-3, 6-5

B
backup
database C-2
  procedures C-3
  standard database C-6
  standby database C-6
  system C-5
types C-5

D
database
  backing up C-2
  configuration utility 2-3, 3-5, 4-4, 5-3, 6-5
  creating 2-3, 3-5, 4-4, 5-3, 6-5
  creating a schema C-10
  disk IO configurations 1-5
  exporting C-9
  exporting a schema C-9
  file locations 2-3, 3-6, 4-5, 5-3, 6-6
  four-disk configuration 1-6
  importing C-7
  importing a schema C-7
  index settings C-1
  installing 3-2, 4-2, 6-2, A-2, B-4
  IP addresses C-2
  listener 2-4, 2-5, 3-8, 4-7, 5-4, 5-5, 6-9
  monthly maintenance C-1
  network connection 3-8, 4-8, 6-10
  network connectivity A-1, B-1
  nine-disk configuration 1-6
  one-disk configuration 1-6
  operating system 3-2, 4-2, 6-2, A-1, B-1
  pre-requisites 3-2, 4-2, 6-2
  recovering C-12
  removing an instance C-11
  restoring C-12
  schema name and password 2-3, 5-3
  schemas C-10
  scripts C-12
  SID 2-3, 3-5, 4-4, 5-3, 6-5
  Solaris 3-2, 4-2, 6-2
  standard backup C-6
  standby backup C-6
  Windows 2-1, 5-1
date and time A-2, B-2

E
exporting
database C-9
  full Oracle database C-9

F
file locations, database 2-3, 3-6, 4-5, 5-3, 6-6

I
importing the database C-7
index settings C-1
installing
  Oracle database
  Solaris 3-2, 4-2, 6-2
  system requirements 3-2, 4-2, 6-2
  Windows 2-1, 5-1, A-2, B-4
  starting 2-2, 5-2
instance, removing C-11
IP addresses, database C-2

L
listener, database 2-4, 2-5, 3-8, 4-7, 5-4, 5-5, 6-9

M
monthly database maintenance C-1

N
network connection
database 3-8, 4-8, 6-10

O
Oracle database
  backing up C-2
  creating 2-3, 3-5, 4-4, 5-3, 6-5
  creating a schema C-10
  disk IO configurations 1-5
  exporting C-9
  exporting a schema C-9
  file locations 2-3, 3-6, 4-5, 5-3, 6-6
  four-disk configuration 1-6
  importing C-7
  importing a schema C-7

P
prerequisites
  Oracle database on Solaris 3-2, 4-2, 6-2
Product Interchange database
  Solaris 6-5
  upgrading 7-1
  Windows 5-3

R
recovering a database C-12
removing an instance C-11
requirements
  Agile 9.2.1 1-1, 1-2
  Oracle database on Solaris 3-2, 4-2, 6-2
  restoring a database C-12

S
schema
  creating C-10
  exporting C-9
  importing C-7
  name 2-3, 5-3
  password 2-3, 5-3
  schemas C-10
scripts C-12
sizing and tuning
   disk IO configurations 1-5
   four-disk configuration 1-6
   nine-disk configuration 1-6
   one-disk configuration 1-6
software requirements, Agile 9.2.1 1-2
Solaris database
   creating 3-5, 4-4, 6-5
   file locations 3-6, 4-5, 6-6
   installing 3-2, 4-2, 6-2
   network connection 3-8, 4-8, 6-10
   pre-requisites 3-2, 4-2, 6-2
   SID 3-5, 4-4, 6-5
SQL scripts C-12
standby database backup C-6
starting the installer 2-2, 5-2
system backup C-5
system requirements 1-2
   Agile 9.2.1 1-1
   Oracle database on Solaris 3-2, 4-2, 6-2
U
upgrading
   Product Interchange database 7-1
   system requirements 1-2
W
Windows
   Agile 9.2.1
   software requirements 1-2
   Agile 9.2.1 requirements 1-1
   database
      creating 2-3, 5-3
      file locations 2-3, 5-3
      installing A-2, B-4
      listener 2-4, 2-5, 3-8, 4-7, 5-4, 5-5, 6-9
      network connectivity A-1, B-1
      prerequisites A-1, B-1
      SID 2-3, 5-3
      server date and time A-2, B-2